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Chapter 1 Introduction

1.1 About This Guide

The FME® Server Administrator's Guide is intended for system admin-
istrators and those who are responsible for installing and configuring FME Server
in aWindows, Linux, or UNIX environment.

This document assumes that system and FME Server administrators have knowl-
edge of or access to resources in the following areas:

l The location and structure of the spatial data resources you want to work
with in FME Server

l Your web application architecture

l FMEWorkbench, if you plan on installing FME Desktop and authoring work-
spaces

1.2 Additional FME Server Resources

Safe Software provides the following resources to assist with your learning about
FME Server:

l FMEpedia

FMEpedia is the online source for all information on Safe Software prod-
ucts including documentation, demos and support resources:

http://FMEpedia.com

l Product documentation

Themost up-to-date product documentation is available on FMEpedia.

Installed product documentation is available in the FME Server installation
directory > Docs.

FME Server product documentation includes:
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l FME Server Administrator’s Guide: Information on installation,
licensing, upgrading and common configurations.

l FME Server Tutorial: An introductory course on authoring and pub-
lishing in FME Server.

l FME Server ReferenceManual: Developer resources and detailed
technical documentation.

l FME Server REST API Specifications: Developer reference for
working with the REST API.

l FME Server Developer's Guide: Quick-start, tutorial and sample
code for working with the FME Server APIs.

l Training

Training courses on FME Desktop and FME Server (offered by Safe Soft-
ware and our reseller network)

The current public training calendar is available from:

http://www.safe.com/learning> Course Schedule

Contact your Safe Software account manager or your FME reseller to
arrange a private training course for your organization.

1.3 About FME Server

FME Server lets your organization address diverse spatial and non-spatial data
requirements using a single enterprise solution. FME Server provides a Service-
Oriented Architecture (SOA) that brings all the capabilities of the FME platform
to a server environment, creating a full Spatial Extract, Transform, and Load
(ETL) capability.

The capabilities of FME Server are presented through a number of interfaces.
These interfaces include:

l Web-based services provided with FME Server – for example, Data Down-
load

Chapter 1   Introduction
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1.4   FME Server Roles

l Application interfaces including theWebUser Interface, FME Server Con-
sole, and FMEWorkbench

l Programmatic interfaces, such asC++, Java, .NET, and REST APIs

Through these interfaces, organizations can apply the power of FME at the organ-
ization or web level for the first time.

Like the FME Desktop product, FME Server tasks are authored in FMEWork-
bench and published to FME Server directly fromWorkbench. It's very easy to
move tasks from FME Desktop to FME Server or to run tasks using both appli-
cations.

1.4 FME Server Roles

There are four distinct server roles in the FME Server context:

l Administrator—person who installs andmaintains FME Server and its
related services. Administrators' tasks include:

l Planning system architecture

l Installing prerequisites

l Installing FME Server

l Setting up services

l Monitoring services and jobs

l Troubleshooting

l Scaling, as required

Administrators use this guide for information pertinent to their role.

l Author—person who createsworkspaces and publishes them to FME
Server for use by users. Typically, authors are experienced FME users with
a good understanding ofWorkbench, published parameters, and the
source data formats they use.
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l User—person who accesses data using an FME Server Service. There is
no expectation that a user has any experience with FME, nor do users
need to be aware of FME Desktop or FME Server.

l Developer—person who develops applications that submit jobs to FME
Server and handle the results. Developers can include FME Server serv-
iceswithin their own applications or create their own services using the
FME Server API.

Chapter 1   Introduction
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2.1   Obtaining the Installer

Chapter 2 Before You Begin

This chapter describes the steps for installing FME Server on any of the supported
platforms. If you are upgrading from a previous version of FME Server, see
"Upgrading FME Server" on page 73.

2.1 Obtaining the Installer

The download web page, which contains the FME Server installation package, is
located here: http://www.safe.com/support/support-resources/fme-downloads/. The
web page also includes download links to release and beta installation packages
for various platforms.

To request a 60-day trial license of FME Server, visit
http://www.safe.com/fme/fme-technology/fme-server/trial-download/.

You can also contact sales@safe.com to get access.

2.2 System Requirements

For system requirements for theWindows, Linux, or UNIX operating systems, see
www.safe.com/products/server/specifications.php.

2.3 Installation Options

The FME Server installer provides three options for installation: express, engine
and custom. These options are described below.

2.3.1 Express

The express option installs all prerequisites, so you can immediately license and
start working with FME Server. The express option is the easiest to get started
with, and we recommend that you use this option unless there is a compelling rea-
son to do otherwise.

2.3.2 Engine

This option allows you to install an FME Engine and configure it to use an FME
Server Core you have deployed on another Server.
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2.3.3 Custom

The custom option ismore flexible. It allows you to select which prerequisites to
install yourself and which should be installed automatically. The custom option is
mainly useful for installing FME Server in a distributed environment.

Both the Engine and Custom options are useful in the following scenarios:

l "Performing an Installation for High Capacity" on page 23

l "Performing an Installation for High Availability" on page 27

2.3.3.1 License Server

Note: We recommend using the Default License Server provided with
FME Server.

You have the option to use a separately installed License Server or have one
installed by the FME Server Installer. The license request process is the same
either way. However, if you want to use a separate License Server, youmust
install it prior to installing FME Server, or, if it is already installed and running,
youmust know its host name.

2.4 File Permissions

The user account that starts the FME Server servicesmust have permission to
read and write files in the FME Server installation directory. This user account
also requires permission to access any directories or resources required by a
workspace.

If you specify anyUNC paths or mounted directories in the FME Server instal-
lation, the user that starts the FME Server services needswrite access to those
directories.

If you are not using the Application Server included with FME Server, then the
user that is running your Application Server needs the same permissions as the
user that starts the FME Server services above.

Chapter 2   Before You Begin
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2.5   Requirements for Email Notification

2.5 Requirements for Email Notification

If you want FME Server to send notification emails after jobs are complete, you
must know the IP address and port number of your SMTP server, as well as any
required authentication information. Instructions for configuring email notification
after the installation are available in "Configuring FME Server to Send Email Noti-
fications" on page 106.

2.6 Requirements for FME Workspaces

To perform data transformations, FME Server runsworkspaces.When a work-
space runs on FME Server, it is referred to as a job.

2.6.1 FME Workbench

FMEWorkbench is used to author and publish the workspaces used by FME
Server. FMEWorkbench is not part of FME Server; rather, it is part of the FME
Desktop product. Contact your Safe Software account manager or your local
Safe Software reseller, if you would likemore information about FME Desktop.

If you don't have access to FME Desktop, you cannot publish workspaces to FME
Server, although you can still perform and test the installation.

2.6.1.1 Connecting to FME Server

There are twomethods for connecting FMEWorkbench to FME Server:

l Direct connection allows communication between the FMEWorkbench
computer and the FME Server computer on your local area network. It
requires the TCP/IP port 7071 to be open to communication between the
FMEWorkbench computer and the FME Server computer.

l Web connection allows FMEWorkbench to connect to FME Server using
the HTTP protocol. It requires theWeb Application Server port to be open
to communication between the FMEWorkbench computer and the FME
Server computer.

2.6.1.2 Version of FME Workbench

The version of FMEWorkbench you usemust match the FME Server version you
have installed. This requirement ensures that the workspaces you author will run
when published to FME Server.
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If you are running an FME Server version that is older than your FMEWork-
bench, it is possible to upgrade the FME Engines used by FME Server to match
your FMEWorkbench version. Instructions for upgrading the FME Engine only
are available in "FME EngineOnly Upgrade" on page 91

2.6.2 Custom Coordinate Systems

If you have a custom coordinate system defined for your FME Desktop instal-
lation, repeat the configuration process on the FME Server computer. Instruc-
tions for installing custom coordinate systems are available in "Custom
Coordinate Systems" above.

2.6.3 GridShift Files

If you plan to run workspaces that transform data between the datumsNAD27
and NAD83, you can use datum shift files for Canada or the US. Instructions for
configuring GridShift files are available in the "Configuring Grid Shift Files" on
page 108.

2.6.4 Third-Party Applications for FME

FMEWorkspaces often rely on third party applications for connecting to data
sources. Examples include anOracle client for connecting to anOracle data-
base and an ArcGIS installation for connecting to Esri Geodatabases.

If youmust install a third-party application for your FME Desktop installation,
repeat that installation on your FME Server computer.

2.7 Default User Accounts and Passwords

The FME Server installer prompts you for an administrator account username
and password. This account has permission to use all FME Server resources,
including theWebUser Interface. Make sure to write downwhat you enter. In
addition to that account, three other accounts are provided by default.

Username/Password Description

user/user An account
intended for
Web User Inter-
face

Chapter 2   Before You Begin
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2.7   Default User Accounts and Passwords

Username/Password Description

author/author An account
intended for
FME Workbench
authors

guest/guest An account that
provides unau-
thenticated
access to the
web services
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3.1   Express Installation for Windows

Chapter 3 Performing an Express Installation

3.1 Express Installation for Windows

This chapter provides information for an express installation of FME Server for
Windows. Before getting started, take a few minutes to review "Before You
Begin" on page 5.

If this FME Server installation will be external facing (e.g. fmeserver.com), then
you should do the following:

1. ConfigureWindows to route FME Server communication requests inter-
nally instead of over the internet. To do this:

l Open the following file:

C:\windows\system32\drivers\etc\hosts

l Add an entry from 127.0.0.1 to the external hostname. Here is the
entry for fmeserver.com:

127.0.0.1 fmeserver.com

2. During installation, specify the external hostname that users will enter when
connecting to FME Server (e.g. fmeserver.com).

3.1.1 Run the Installer

Run the installer logged in as the user who will be running your FME Server
Service.  This user must have write privileges to the installation directory. 

Start the installer, and proceed through to the Choose Setup Type prompt. Select
the Express option.
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Follow the instructions on the screen.We recommend that you use port 80 when
prompted. Don’t forget to note the password you enter for the administrator
account. On the last screen, click Finish.

Chapter 3   Performing an Express Installation
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3.1   Express Installation for Windows

Note: If you already have an existing web server, such as IIS, it is likely to
already be using port 80. In that case, turn off IIS or select a dif-
ferent port, such as 8080.

Proceed to "Starting and Stopping FME Server" below.

3.1.2 Starting and Stopping FME Server

After performing the installation, the FME Server service and associated appli-
cations start automatically. Youmight have to start and stop these applications at
some point. See "Starting the Services" on page 97 for instructions.

Note: If UAC (User Account Control) is enabled on your Windows system
and the installation was not run from an elevated prompt (that is,

FME Server Administrator's Guide 13



Run as administrator), youmight need to start the FME Server
WindowsServices. See "Configuring Start-up" on page 95.

3.1.3 Licensing

If you are performing an express install or installing FME Engineswith the cus-
tom install option, the FME Enginesmust be licensed. See "Licensing" on page
61 for instructions on acquiring a license.

3.1.4 Verify the Installation

For instructions on starting and stopping FME Server, the Database Server, the
Web Application Server, and the License Server, if installed, see "Starting the
Services" on page 97.

Confirm that the Web Services are available:

Open theWebUser Interface in a web browser:

http://<host>:<port>/fmeserver

If you see a login form, it means that theWeb Application Server is running, the
web applications have been deployed, and you specified the correct port when
accessing theWebUser Interface.

Note: If you are using a non-standard port, enter the port number after
the host name, for example:

http://localhost:8080/fmeserver

Confirm that FME Server is available:

Log in to theWebUser Interface with the username and password you entered
during installation.

l If you are able to log in , it confirms that FME Server is installed and run-
ning.

l If you cannot access theWebUI, the page shows a Server error, or you
can confirm that FME Server is not running, youmight have a problem
with installation. Contact fmeserversupport@safe.com.

Chapter 3   Performing an Express Installation

14 FME Server Administrator's Guide

mailto:fmeserversupport@safe.com


3.1   Express Installation for Windows

Confirm that the FME Engines are licensed:

Log in to theWebUser Interface with the username and password you entered
during installation.

The home page lists the licensed and running FME Engines.

If there are no FME Engines, your FME Server might not be licensed. Confirm
that you have an FME Engine floating license available. See "Licensing" on page
61for instructions on acquiring a license.

If you confirm that you have a floating license available, reconfigure the license
server that FME Engines are using, and restart FME Server. See "Licensing" on
previous page and "Starting and Stopping FME Server" on page 13.

If you still do not see active FME Engines in theWebUser Interface, send the fol-
lowing information to fmeserversupport@safe.com:

l From the License Server directory, include the following files :

<FMEServerDir>\Utilities\flexserver\safe.log

<FMEServerDir>\Utilities\flexserver\safe.lic

l From the FME Server computer, include themost recent copy of the fol-
lowing logs:

<FMEServerDir>\Logs\processMonitor_xx.log

<FMEServerDir>\Logs\fmeServer_xx.log

FME Server Administrator's Guide 15
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Confirm that FME Server can run a job:

After you confirm that your FME Engines are licensed, confirm that FME Server
can perform its primary function—running a job.

1. Open theWebUser Interface in a web browser by going to:

http://<host>/fmeserver

Note: If you are using a non-standard port, enter the port number
after the host name, for example:

http://localhost:8080/fmeserver

2. Log in with the administrator account that you created during install.

3. Click Repositories > Samples > austinApartments.fmw. Under Job Sub-
mitter, click Run.

If you see a successmessage, your install was a success.

Chapter 3   Performing an Express Installation
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3.2   Performing the Installation for Linux/UNIX

3.1.5 Uninstalling

Note: Before you upgrade to a newer version of FME Server, see
"Upgrading FME Server" on page 73 for instructions on backing
up your existing configuration. Youmust uninstall any previous ver-
sions of FME Server before installing an upgrade.

Ensure that FME Server, FME Server SMTP Relayer, FME Server Application
Server, or other Web Application servers are shut down before proceeding.

You can uninstall FME Server as you would any other program by selecting Start
menu > Control Panel > Programs and Features > FME Server.

Note: Uninstalling FME Server removes the contents of your Tomcat
directory if you installed the default Web Application Server. This
folder is located in the FME Server installation directory under
Utilities\tomcat. If youmade custommodifications to this
Tomcat, thesemodifications should be backed up before uninstall.

3.2 Performing the Installation for Linux/UNIX

This chapter provides information for an express installation FME Server for Linux
or UNIX. Before getting started, take a few minutes to review "Before You Begin"
on page 5.

3.2.1 Run the Installer

Run the installer logged in as the user who will be running your FME Server
Service.  This user must have write privileges to the installation directory. 

Start the installer, and proceed through to the Choose Setup Type prompt. Select
the Express option.
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Proceed through all the prompts. We recommend that you use port 80 when
prompted.

Chapter 3   Performing an Express Installation
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3.2   Performing the Installation for Linux/UNIX

Don’t forget to note the password you enter for the administrator account. For
each prompt, the default answer appears in square brackets, such as [default].
If you press Enter without typing an answer, you are accepting the default
answer. 

Note: If you select port 80 or any port number less than 1024 for the
default Web Application Server, start that service as root.

Proceed to "Starting and Stopping FME Server" on next page.
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3.2.2 Starting and Stopping FME Server

After performing the installation, manually start FME Server, the Database
Server, theWeb Application Server, and the License Server, if installed. For
instructions on starting and stopping these applications and for configuring the
applications to start at boot time, see "Starting the Services" on page 97.

3.2.3 Licensing

If you are performing an express install or installing FME Engineswith the cus-
tom install option, the FME Enginesmust be licensed. See "Licensing" on page
61 for instructions on acquiring a license.

3.2.4 Verify the Installation

For instructions on starting and stopping FME Server, the Database Server, the
Web Application Server, and the License Server, if installed, see "Starting the
Services" on page 97.

Confirm that the Web Services are available:

Open theWebUser Interface in a web browser:

http://<host>:<port>/fmeserver

If you see a login form, it means that theWeb Application Server is running, the
web applications have been deployed, and you specified the correct port when
accessing theWebUser Interface.

Note: If you are using a non-standard port, enter the port number after
the host name, for example:

http://localhost:8080/fmeserver

Confirm that FME Server is available:

Log in to theWebUser Interface with the username and password you entered
during installation.

l If you are able to log in , it confirms that FME Server is installed and run-
ning.

Chapter 3   Performing an Express Installation
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3.2   Performing the Installation for Linux/UNIX

l If you cannot access theWebUI, the page shows a Server error, or you can
confirm that FME Server is not running, youmight have a problemwith
installation. Contact fmeserversupport@safe.com.

Confirm that the FME Engines are licensed:

Log in to theWebUser Interface with the username and password you entered
during installation.

The home page lists the licensed and running FME Engines.

If there are no FME Engines, your FME Server might not be licensed. Confirm
that you have an FME Engine floating license available. See "Licensing" on page
61 for instructions on acquiring a license.

If you confirm that you have a floating license available, reconfigure the license
server that FME Engines are using, and restart FME Server. See "Licensing" on
previous page and "Starting and Stopping FME Server" on previous page.

If you still do not see active FME Engines in theWebUser Interface, send the fol-
lowing information to fmeserversupport@safe.com:

l From the License Server directory, include the following files :

<FMEServerDir>\Utilities\flexserver\safe.log

<FMEServerDir>\Utilities\flexserver\safe.lic

l From the FME Server computer, include themost recent copy of the fol-
lowing logs:

<FMEServerDir>\Logs\processMonitor_xx.log

<FMEServerDir>\Logs\fmeServer_xx.log

Confirm that FME Server can run a job:

After you confirm that your FME Engines are licensed, confirm that FME Server
can perform its primary function—running a job.

1. Open theWebUser Interface in a web browser by going to:

http://<host>/fmeserver
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Note: If you are using a non-standard port, enter the port number
after the host name, for example:

http://localhost:8080/fmeserver

2. Log in with the administrator account that you created during install.

3. Expand Job Submitter, Samples, and click Run next to aus-
tinApartments.fmw.

If you see a green successmessage, your install was a success.

3.2.5 Uninstalling

Note: Before you upgrade to a newer version of FME Server, see
"Upgrading FME Server" on page 73 for instructions on backing
up your existing configuration. Youmust uninstall any previous
versions of FME Server before installing an upgrade.

Ensure that FME Server, FME Server SMTP Relayer, FME Server Application
Server, or other Web Application servers are shut down before proceeding.

Run the uninstall.sh script in the FME Server installation directory.  To
ensure that everything gets uninstalled, run this script as root.

Note: Uninstalling FME Server removes the contents of your Tomcat
directory if you installed the default Web Application Server. This
folder is located in the FME Server installation directory under
Utilities\tomcat. If youmade custommodifications to this
Tomcat, thesemodifications should be backed up before unin-
stall.

Chapter 3   Performing an Express Installation
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4.1   Install the FME Server Core

Chapter 4 Performing an Installation for High Capacity

If you want to add processing capacity to your FME Server installation, you can
install additional FME Engines on a separate computer from the FME Server
Core.

The FME Server Core contains a Software Load Balancer (SLB) that distributes
jobs to FME Engines. A single active Core that supportsmultiple engines is all that
is required to scale processing capacity.

The computer that hosts the FME Server Core where jobs are sent and where
jobs are queued from is referred to as the <coreHost>. The computer that hosts
the FME Engines is referred to as the <engineHost>.

4.1 Install the FME Server Core

Install the FME Server core by running the FME Server installer (<coreHost>).

1. Start the FME Server Installer.

2. When prompted, select either the Express or Custom setup type.
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3. Follow the remaining dialogs to complete the installation. If Custom setup
was selected, make sure FME Server Core Components is selected on
the CustomSetup dialog.

Youmight have to disable any firewalls that are running on this computer.

4.2 Install the FME Engines

Install the FME Engines by running the FME Server installer on another com-
puter (<engineHost>).

4.2.1 Windows

1. Start the FME Server Installer.

2. Select the Engine setup type.

3. On the FME Server Hostname dialog, enter the hostname of the <core-
Host> computer.

4. On the Existing Repository Directory dialog, provide the UNC path to the
repository directory. (In most cases, the directory is the same as the
<coreHost> repository directory.)

4.2.2 Linux/UNIX

1. Mount the FME Server Core installation directory shared by <coreHost>:

mount <coreHost>:<FMEServerDir>/home/FMEServer

2. Start the FME Server Installer.

3. Select the Engine Install.

4. Choose to install only the FME Engine component by selecting Yes to the
FME Engine component prompt and No to the other component prompts.

The installer prompts you for the path to the <coreHost> installation direc-
tory.

5. Enter the path to themounted directory.

The installer prompts you for the name of the FME Server Host.

6. Enter the host name of the <coreHost> computer.

Chapter 4   Performing an Installation for High Capacity
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4.2   Install the FME Engines

7. Manually start FME Server, and configure it to start automatically.

See "Configuring Start-up" on page 95.

Youmay have to disable any firewalls that are running on this computer.

The installation on <engineHost> starts two FME Engines by default. The FME
Engines start and then register with the FME Server Core running on <core-
Host>. You can confirm that the FME Engineswere added by logging into the
WebUser Interface and looking for active FME Engines that are from the
<engineHost>.

If you want this computer to start more or less FME Engines, follow the steps in
"Licensing" on page 61.

To verify the installation, see "Verify the Installation" on page 14 (Windows) or
"Verify the Installation" on page 20 (Linux).

FME Server Administrator's Guide 25



26 FME Server Administrator's Guide



5.1   About FME Server High Availability

Chapter 5 Performing an Installation for High Availability

This chapter provides information on performing an installation for maintaining
FME Server in a high availability/failover environment.

5.1 About FME Server High Availability

5.1.1 Job Recovery

Job recovery ensures that submitted jobs are not dropped completely, if the con-
nection to the FME Engine is lost for any reason.

After FME Server submits a translation request to an FME Engine, it monitors the
connection to that engine until a response is returned. If the connection to the
engine is lost, FME Server can resubmit the job.

The default configuration is to retry a failed job three times only, which prevents
FME Server from indefinitely retrying a job that fails.

5.1.1.1 Configuring Job Recovery

On the FME Server host computer, the MAX_FAILED_TRANSACTION_REQUEST_
RETRIES parameter in the <FMEServerDir>\Server\fmeServerConfig.txt
file determines the number of times any transaction is resubmitted before FME
Server stops resending the request.

It is important to remember that a failed translation request could cause an FME
Engine to shut down improperly. When nomaximum limit is imposed, this trans-
lation is resent indefinitely, which causes repeated FME Engine failures. A value
of 0means that nomaximum limit is imposed and failed transaction requests are
resubmitted indefinitely. If this parameter is absent, a default value of 3 is used.
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5.1.2 Automatic Restart of FME Server Core and Engines

The ProcessMonitor is responsible for ensuring that the FME Server Core and
the FME Engines are always up and running. The ProcessMonitor provides
fault tolerance by restarting the FME Server Core and any FME Engineswhen
needed. No intervention is required.

5.1.3 Managing Job Distribution Between FME Engines

Job Routing is amechanism for sending specific jobs to specific FME Engines.
The reasons for doing this include:
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l Reserving an FME Engine for a scheduled task

l Reserving an FME Engine for quick jobs

l Sending jobs to an FME Engine that supports a particular format (for exam-
ple, MS Access is not supported on UNIX)

Job routing can be configured after installation. For more information, see "Con-
figuring Job Routing" on page 109.

5.1.4 Core Failover

FME Server includes a number of failover mechanisms that allow various com-
ponents to connect to backup components in the event of failure. However, FME
Server administratorsmust understand that a standard FME Server cluster does
not provide complete fault tolerance. Configuring a fault tolerant cluster requires
the following components:

l FME Server Core—Configure the primary FME Server and a failover FME
Server to use the same common database and a common repository direc-
tory.

l FME Server Services—Configure FME Server services to switch to the fail-
over FME Server when the connection to the primary FME Server is lost. A
Web Application Server must be installed on a separatemachine and con-
figured for high availability.

l FME Engines—Configure one set of engines for the primary Core and one
set for the failover Core. Further, to ensure there is no single point of failure,
you should install at least one FME Engine on amachine separate from the
FME Server Core.

Note: To ensure failover capability of any source data files or databases
used in your FME workspaces, the following additional com-
ponents are required:

l A database server installed on a separatemachine

l A file system installed on a separatemachine..
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5.1.4.1 Failover Architecture

The following diagram shows the basic structure of FME Server failover.

Note: To limit hardware costs, two instances of Engine 1 can be on the
samemachine, with one instance connected to the Primary host
and the other to the Failover host. See "Configuring FME
Engines for Failover" on page 34 below.
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When the Core A machine fails, clients connecting to Core A failover to Core B.
Because the Failover Core is now the “active” Core of the cluster, clients sub-
sequently always connect to the Failover Core so that processing continues.
When a heartbeat failure is detected, this Faillover Core takes over Jobs and
Schedules.

When the Core A machine and associated Engines are restored, Core B remains
the Active Core, while Core A is now online as the Failover Core.

Note: Notification Service publishers (including UDP, Email and JMS
clients) do not failover. These clientsmust bemanually recon-
figured to connect to the active core.

5.1.4.2 Configuring FME Server Core for Failover

The first FME Server Core that starts up in a fault tolerant cluster automatically
becomes the Primary “active” Core. The second FME Server Core to start up
becomes the Failover Core.When configured, the fault tolerant cluster auto-
matically reconfigures itself depending on the state of the system.

Prior to installation, youmust create and share the directory where the common
FME Server files will exist (repository directory), so that each FME Server Core
can access it (read and write). The repository directory should be on its own redun-
dant file server, not the samemachine as the FME Server Core installation. Then,
during installation, provide the UNC/mount path to the repository directory, ensur-
ing that you use the same directory for each FME Server Core installation.

When you bring the primary server back online, it is not necessary to shutdown
the secondary server unless you want clients to fail back to the primary server.
Youmight want to fail back if the primary server is amore capable system than the
failover server.

The following instructions apply to both the primary and failover server. Additional
parameters to configure a failover cluster can be found in the FME Server con-
figuration file.

1. Open the FME Server configuration file at:

<FMEServerDir>\Server\fmeServerConfig.txt

2. Comment-out the Default Cluster directive CLUSTER_TYPE=DEFAULT:
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#CLUSTER_TYPE=DEFAULT

3. Uncomment the Failover Cluster directive #CLUSTER_TYPE=FAILOVER:

CLUSTER_TYPE=FAILOVER

4. Uncomment the FAILOVER_MONITOR_HOST directive and specify the
name of the host to monitor. If working on the primary server, then specify
the name of the failover server. If working on the failover server, then spec-
ify the name of the primary server.

The host name value corresponds to the FME_SERVER_HOST_
NAME setting of themonitored host. This value is case sensitive
and is typically all upper case in a default installation. It is best to con-
firm by checking the FME_SERVER_HOST_NAME value of the
monitored host.

FAILOVER_MONITOR_HOST=<FME_SERVER_HOST_NAME>

5.1.4.3 Configuring FME Server Services for Failover

You can configure individual FME Server services to switch to a backup FME
Server Core when the connection to the primary FME Server Core is lost. This
capability is called "service failover".

When a service loses its connection to the primary FME Server Core, the serv-
ice attempts to connect to a backup FME Server Core you define. In a fault tol-
erant cluster, a primary FME Server Core can only have one backup FME
Server Core.
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1. Open each web application properties file located at:

<WebAppDir>\<fmeServiceName>\WEB-

INF\conf\propertiesFile.properties

2. Find the following line in this file:

#FAILOVER_SERVER_NAMES=<failoverServerName>

3. Uncomment this line and replace <failoverServerName>with a host
name.

The host namemust be running an FME Server, for example:

FAILOVER_SERVER_NAMES=red
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This example defines an FME Server system—red—whichmust be running
an FME Server.

4. Restart the web application server.

5.1.4.4 Configuring FME Engines for Failover

We recommend configuring redundant FME Engines for both the primary FME
Server Core and the secondary FME Server Core. If you wish to limit the
number of machines used, you can start up FME Engineswith the same name
on the samemachine, with one engine connected to the primary FME Server
Core and the other connected to the failover FME Server Core.
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5.1.4.5 Configure a Notification When Failover Occurs

System notifications, such as via an email or amobile client subscription, can be
configured so that you are alerted of the status of the Failover cluster. Status noti-
fications can include when the FME Server starts up, when a host fails to detect
the host it ismonitoring, and when a failover operations occurs.

Perform the following steps for both the FME Server primary and failover server.
We recommend that topic names be different between servers to distinguish noti-
ficationmessages.

1. Open the FME Server configuration file

<FMEServerDir>\Server\fmeServerConfig.txt

2. Specify the topic name to send failover notifications to

NOTIFY_FAILOVER=<topicName>

For more information about configuring notifications, see the Notification Service
section of the FME Server ReferenceManual.

5.2 Installing for Core Failover

5.2.1 Before Installation

5.2.1.1 Provide a Database Server

If you have a supported Database Server installed already, you can use it for FME
Server's repository database. Otherwise, you can install one of the supported
databases on a separatemachine. The database referred to here is used by FME
Server for managing FME Server jobs and workspace information and does not
refer to a source or destination data source for FME workspaces.

The option to use your own database can only bemade during installation. Prior to
installation you should have a Database Server running, the connection infor-
mation, and the ability to create a new database using SQL scripts.

Supported database servers include:

l Oracle

l PostgreSQL
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l SQL Server

Note: For information about configuring the Database Server for fail-
over, see "Create the FME Server Database on a Separate Data-
base Server" on the facing page.

5.2.1.2 Provide a Web Application Server

The FME Server web servicesmust switch to the failover FME Server when the
connection to the primary FME Server is lost. A Web Application Server must be
installed on a separatemachine and configured for high availability.

5.2.1.3 Provide a Remote File System

Each of the procedures in this chapter requires that specific directories be
shared to enable access from different computers.

Create the directory where the FME Server Core components will be installed
and share it so that the other computers involved in the installation can access
and write to it.

5.2.2 Perform the Installation

Note: The computer that hosts the FME Server Core where jobs are
sent and where jobs are queued from is referred to as the <core-
Host>. The computer that hosts theWeb Services is referred to
as the <webHost>.

5.2.2.1 Install the FME Server Core (Primary and Secondary)

Install the FME Server core—on both the primarymachine and the secondary
machine—by running the FME Server installer (<coreHost>).

1. Start the FME Server Installer.

2. Select the Custom install option.

3. On the CustomSetup dialog, be sure to select, at minimum, the FME
Server Core Components.

4. Follow the remaining dialogs to complete the installation.

Youmight have to disable any firewalls that are running on this computer.
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5.2   Installing for Core Failover

5.2.2.2 Create the FME Server Database on a Separate Database Server

This section provides instructions on how to configure FME Server to use a sep-
arate Database Server. ConfiguringMicrosoft SQL Server, PostgreSQL and
Oracle running on bothWindows and Linux/UNIX are described.

Note: If you chose the Express Install option or selected to use the default
FME Server Database Server with Custom Install then you
already have all that is required to run FME Server and there is no
need to read this appendix.

Configuring FME Server to use a separate database server involves the following
steps:

1. Database Configuration – This involves setting up FME Server database
tables and database users with permissions to access the FME Server data-
base.

Note: The specific way to set up database tables and user per-
missions on various production databasesmay differ
depending on the available database tools and intended tar-
get platform.

2. Post-configuration scripts - These scripts enable the installed services, sam-
ple workspaces, and notification subscribers.

Note: FME Server connects to the Database Server when it starts.
Therefore, ensure that this Database Server is running
before FME Server is started.

Database Configuration

Microsoft SQL Server

It’s assumed that SQL Server has been installed.

One notation used is <FMEServerDir>, which is the installation directory of FME
Server. InWindows, this is typically C:\Program Files\FMEServer.

FME Server Administrator's Guide 37



SQL scripts are provided to help with SQL Server database configuration.
These SQL scripts are located in the <FMEServerDir>\Server\-
database\sqlserver\ directory.

If you are upgrading, you should back up any job history you want to keep. You
will also need to drop the existing FME Server database using the following SQL
scripts:

<FMEServerDir>\Server\database\sqlserver

sqlserver_dropUser.sql

sqlserver_dropDB.sql

The SQLServer_createDB.sql script creates the required FME Server tables.

1. Install Microsoft SQL Server if you haven’t already.

2. Open the SQL Server Management Studio and connect to the SQL
Server database engine.

3. Open sqlserver_createDB.sql and run the script against the fme-
server database, as shown below:
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4. On theObject Explorer pane, expand the Security folder, right-click Login,
and then select New Login:
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5. On the Login – New page, clickGeneral to open the page shown in the
example below.

l At the Login name field, enter fmeserver.

l Make sure the option button is active for SQL Server authen-
tication.

l In the Password field enter the password of your choice, and in the
Confirm password field enter the same password again.

l Make sure the Enforce password policy is active. If not, click the
checkbox to activate it.

l If required, click the checkbox for Enforce password expiration to
clear it.
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l At the Default database field enter fmeserver.

6. On the same Login – New page, click User Mapping to open the page
shown in the next figure.

l At the Usersmapped to this login location, in theMap column click
the checkbox to activate it andmap the login name to the fmeserver
database.

l At the Database rolemembership for location, notice that the fme-
server database is specified and check db_owner to assign that role
to this database.

FME Server Administrator's Guide 41



l ClickOK to close this page.

Oracle

It’s assumed that Oracle database is installed.

One notation used is <FMEServerDir>, which is the installation directory of FME
Server. InWindows, this is typically C:\Program Files\FMEServer.

If you are upgrading, you should back up any job history you want to keep. You
will also need to drop the existing FME Server database using the following SQL
script:

<FMEServerDir>\Server\database\oracle

Chapter 5   Performing an Installation for High Availability

42 FME Server Administrator's Guide



5.2   Installing for Core Failover

oracle_dropUser.sql

Windows

This section describes how to configure anOracle database. You can configure
the Oracle database from other Oracle database tools depending on your per-
sonal preference.

For anOracle database configuration, various SQL scripts are provided to help.

These SQL scripts are located in the <FMEServerDir>\Server\-
database\oracle directory.

l oracle_createUser.sql – This script creates FME Server database user
and password, and grants all required permissions to the FME Server data-
base user. By default, the user and password are both named fmeserver.

l oracle_createDB.sql – This script creates all FME Server related data-
base packages, tables, indexes, views, and triggers.

l oracle_dropUser.sql – This script drops the FME Server database user
and the database packages, tables, indexes, views, and triggers associated
with the FME Server database user.

Using the Command Prompt

To use the command prompt to configure the database, follow these instructions:

1. Install Oracle SQL*Plus, if you haven’t already.

2. OpenOracle SQL*Plus and log on as a user with adequate privileges, such
as SYSDBA.

In this example, the following parameters were used and entered:

l User: SYS AS SYSDBA

l Password: fmeserver

l String: BD-ORACLE11G:1521/ORCLAS SYSDBA
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3. Create an FME Server database user as follows:

l From the SQL prompt, run the oracle_createUser.sql script by
entering the following command:

@”<F-

MEServerDir>\Server\database\oracle\oracle_

createUser.sql”
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By default, the provided SQL script creates an FME Server database
user named fmeserver with the password fmeserver. The default
TABLESPACE is the Oracle DB configured default. If the created
user doesn’t have read/write permissions on the default TABLES-
PACE, change the default TABLESPACE or create an appropriate
TABLESPACE.

This command creates a TABLESPACE on theOracle DB server
called FMESERVER shown in the following example:

CREATE SMALLFILE TABLESPACE FMESERVER

DATAFILE 'E:\ORADATA\FMESERVER01.DBF' SIZE

100000K REUSE AUTOEXTEND ON NEXT 2048K

MAXSIZE 1024M LOGGING EXTENT MANAGEMENT LOCAL

SEGMENT SPACE MANAGEMENT AUTO DEFAULT

NOCOMPRESS;

By default this command uses the TABLESPACE “FMESERVER”
as shown in the following example:
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CREATE USER fmeserver IDENTIFIED BY

fmeserver DEFAULT TABLESPACE "FMESERVER"

TEMPORARY TABLESPACE "TEMP";

4. When an FME Server database user is created, you can connect to it by
logging on again to SQL*Plus.

In this example, the following parameters were used and entered on the
user interface:

l User: fmeserver

l Password: fmeserver

Note: The preceding example assumes your user name and pass-
word are fmeserver.

5. When connected to the FME Server database, run the oracle_creat-
eDB.sql script by entering the following command:

@”<FMEServerDir>\Server\database\oracle\oracle_

createDB.sql”
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Note: If you drop the FME Server database and login user, run the
oracle_dropUser.sql script.

Linux

Oracle SQL*Plus is a freeware client for connecting to anOracle database. You
can download it from the Internet using the following address:

http://www.oracle.com/technology/software/tech/sql_plus/index.html

For more information, see theOracle web site at:

http://www.oracle.com/technology/sample_code/tech/sql_plus/htdocs/demobld.html

As an FME Server Administrator, youmaywant to use anOracle database with
FME Server rather than the HSQL database, which is installed by default.

The instructions that follow describe how to configure Oracle for use with FME
Server. These instructions describe using SQL*Plus for the database setup.
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Depending on your personal preference, you can also configure the Oracle data-
base using other Oracle tools.

For Oracle configurations, various SQL scripts are provided to help with Oracle
database configuration. These SQL scripts are located in the
<FMEServerDir>/Server/database oracle/ directory.

l oracle_createUser.sql – This script creates FME Server database
user and password, and grants all required permissions to the FME
Server database user. By default, the user and password are both named
fmeserver.

l oracle_createDB.sql – This script creates all FME Server related data-
base packages, tables, indexes, views, and triggers.

l oracle_dropUser.sql – This script drops the FME Server database
user and the database packages, tables, indexes, views, and triggers
associated with the FME Server database user.

Using the Command Prompt

To use the command prompt to configure the database, follow these instruc-
tions:

1. Install the Oracle Client Tools, which includes SQL*Plus, if you haven’t
already.

2. Run sqlplus and log on as a user with adequate privileges, such as
SYSDBA.

For example:

sqlplus SYS/<password>@<Host>:<Port>/<service> AS

SYSDBA

3. Create an FME Server database user. From the SQL prompt, run the
oracle_createUser.sql script by entering the following command:

@”<FMEServerDir>/Server/database/oracle/oracle_

createUser.sql”
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By default, the provided SQL script creates an FME Server database user
named fmeserver with the password fmeserver. The default TABLES-
PACE is the Oracle DB configured default.

If the created user doesn’t have read/write permissions on the default
TABLESPACE, you need to change the default TABLESPACE or create
an appropriate TABLESPACE.

This command creates a TABLESPACE on theOracle DB server called
FMESERVER shown in the following example:

CREATE SMALLFILE TABLESPACE FMESERVER DATAFILE

'/ORADATA/FMESERVER01.DBF' SIZE 100000K REUSE

AUTOEXTEND ON NEXT 2048K MAXSIZE 1024M LOGGING

EXTENT MANAGEMENT LOCAL SEGMENT SPACE MANAGEMENT

AUTO DEFAULT NOCOMPRESS;

By default this command uses the TABLESPACE “FMESERVER” shown
in this example:

CREATE USER fmeserver IDENTIFIED BY fmeserver

DEFAULT TABLESPACE "FMESERVER" TEMPORARY

TABLESPACE "TEMP";

4. When an FME Server database user has been created, you can connect to
it by logging on again to SQL*Plus or by entering the following command:

CONNECT

fmeserver/fmeserver@<Host>:<Port>/<service>;

5. When connected to the FME Server database, run the oracle_creat-
eDB.sql script by entering the following command:

@”<FMEServerDir>/Server/database/oracle/oracle_

createDB.sql”

PostgreSQL

PostgreSQL is an open source database that can be downloaded from the Inter-
net. For more information, see the PostgreSQLweb site at:

http://www.postgresql.com

It’s assumed that PostgreSQL is already installed .
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One notation used is <FMEServerDir>, which is the installation directory of FME
Server. InWindows, this is typically C:\Program Files\FMEServer.

It’s also assumed that you have JRE 5 or higher and PostgreSQL database
installed before you proceed further. If you want to use the JDBC driver, there
are several steps to perform.

If you are upgrading, you should back up any job history you want to keep. You
will also need to drop the existing FME Server database using the following SQL
scripts:

<FMEServerDir>\Server\database\postgresql

postgresql_dropUser.sql

postgresql_dropDB.sql

Windows

This section describes how to configure a PostgreSQL database. You can con-
figure this database from other PostgreSQL database tools, depending on your
personal preference.

For a PostgreSQL database configuration, various SQL scripts are provided to
assist you. These SQL scripts are located in the following directory:

<FMEServerDir>\Server\database\postgresql

l postgresql_createUser.sql – This script creates the FME Server data-
base user and password, and grants all required permissions to this user.
By default, both the user and password are names fmeserver.

l postgresql_createDB.sql – This script creates the FME Server data-
base.

l postgresql_createSchema.sql – This script creates all FME Server
related tables, indexes, views, and triggers.

l postgresql_dropUser.sql – This script drops the FME Server data-
base user.

l postgresql_dropDB.sql – This script drops the FME Server database.
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Using the Command Prompt

To use the command prompt to configure the database, follow these instructions:

1. Install PostgreSQL SQL shell (psql) if you haven’t done so already.

2. Open psql and log on as a user with the appropriate privileges:

3. Create an FME Server database user as follows:

l From the SQL prompt, run the postgresql_createUser.sql script
by entering the following command:

\i

'<FME-

Server-

DIR>/Server/database/postgresql/postgresql_

createUser.sql'

l By default, the provided SQL script creates an FME Server database
user named fmeserver with the password fmeserver:
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4. Create an FME Server database.

From the SQL prompt, run the postgresql_createDB.sql script by
entering the following command:

\i

'

<FMEServerDIR>

/Server/database/postgresql/postgresql_

createDB.sql'

By default, the provided SQL script creates an FME Server database
named fmeserver and grants all privileges on the database to user fme-
server.
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5. Quit psql and log on as the FME Server database user.

6. Create the FME Server database schema as follows:

From the SQL prompt, run the postgresql_createSchema.sql script by
entering the following command:

\i

'

<FMEServerDir>
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/Server/database/postgresql/postgresql_

createSchema.sql'

By default, the provided SQL script creates all FME Server related tables,
indexes, views, and triggers.

Note: The preceding example assumes your user name and password
are fmeserver.

Linux

This section describes configuring PostgreSQL from both the command prompt
and a user interface, such as the PostgreSQLQuery Browser and the Post-
greSQL Administrator.

For PostgreSQL configurations, various SQL scripts are provided to help with
PostgreSQL database configuration. These SQL scripts are located in the <FME-
ServerDir>/Server/database/postgresql/ directory.

l postgresql_createUser.sql – This script creates the FME Server data-
base user and password, and grants all required permissions to the FME
Server database user. By default the user is named fmeserver and the
password is fmeserver.
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l postgresql_createDB.sql – This script drops the FME Server database
and creates a new one with the required FME Server tables. By default this
database is named fmeserver. Be careful when running this script because
it drops the existing FME Server database.

l postgresql_createSchema.sql – This script creates all FME Server
related tables, indexes, views, and triggers.

l postgresql_dropDB.sql – This script drops the existing FME Server data-
base, which is named fmeserver by default.

l postgresql_dropUser.sql – This script drops the FME Server database
user.

Using the Command Prompt

To use the command prompt to configure the database, follow these instructions:

1. Install PostgreSQL Server if you haven’t already.

2. Open a command prompt and change to the following directory, which con-
tains the PostgreSQL SQL scripts:

<FMEServerDir>/Server/database/postgresql/

3. Run the postgresql programwith the postgresql_createDB.sql script:

psql" -d postgres -h <hostname> -p <port> -f

postgresql_createDB.sql

4. Run the postgresql programwith the postgresql_createUser.sql script:

psql -d postgres -h <hostname> -p <port> -f

postgresql_createUser.sql

Note: If you drop the FME Server database and login user, run the post-
gresql programwith the appropriate postgresql_dropDB.sql
or postgresql_dropUser.sql scripts.

After Database Creation

After the database has been created, see Post-Configuration Scripts for an addi-
tional step.

Post-Configuration Scripts
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After configuring the database, youmust run three scripts to finish completing
the installation. These scripts enable the installed services, sample workspaces,
and notification subscribers.

1. Ensure that FME Server is running.

2. OnWindows, run the following scripts:

l Start menu > All Programs > FME Server > Install > Add Sample
Workspaces

l <FMEServerDir>\Clients\utilities\addSubscribers.bat

l Start > All Programs > FME Server > Install > Enable Installed
Services

3. On Linux, run the following scripts:

l <FMEServerDir>/Clients/uti-

lities/configureDemoWorkspaces.sh

l <FMEServerDir>/Clients/utilities/addSubscribers.sh

l <FMEServerDir>/Clients/utilities/addServices.sh

5.2.2.3 Install the FME Server Web Services

Note: We recommend using the Default Web Application Server pro-
vided with FME Server.

Although we recommend using the providedWeb Application Server, you can
use your ownweb application server for running FME Server’s Java web serv-
ices. Youmust know the port number on which your web application server
receives incoming requests and the path to the directory where your web appli-
cation server storesweb application .war files. (This directory is sometimes
called webapps.)

Supported web application servers include:

l Tomcat

l WebLogic
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l JBoss

Note: TheOGC web services are not supported when usingWebLogic.

Windows

1. Start the FME Server Installer on the <webHost>.

2. Select the Custom Install.

3. On the CustomSetup dialog, select only theWeb Services component for
installation.

4. The installer prompts you for the name of the FME Server Host, enter the
hostname of the <coreHost> computer

5. The installer prompts you for the path to the <coreHost> installation direc-
tory. Provide the path (UNC or mapped drive) to the <coreHost> instal-
lation directory you shared on the <coreHost> computer.

The installer prompts you to install aWeb Application Server.

It is recommended that you use the FME Server Web Application Server
and enter port 80 when prompted.

If you have aWeb Application Server already installed on this host, you can
use it instead of the built-in FME Server version. In this case, it is rec-
ommended that you shut down the service during installation.

Linux

1. On the <webHost>, mount the FME Server installation directory shared on
the <coreHost>:

mount <coreHost>:<FMEServerDir>/home/FMEServer

2. Start the FME Server Installer.

3. Select the Custom install option.

4. At the feature selection dialog, select only theWeb Services component.

The installer prompts you for the name of the FME Server Host.
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5. Enter the host name of the <coreHost> computer.

The installer prompts you for the path to the <coreHost> installation direc-
tory.

6. Enter the path to themounted directory.

The installer prompts you to install aWeb Application Server.

We recommend that you use the FME Server Web Application Server
and enter port 80 when prompted.

Note: If you select port 80 or any port number less than 1024 for
the built-inWeb Application Server, start that service as
root.

If you have a web application server already installed on this host, you can
use it instead of the built-in FME Server version. In this case, it is rec-
ommended that you shut down the service during installation.

7. Manually start FME Server and configure it to start automatically.

See "Configuring Start-up" on page 95.

8. In order for the Data Download and Data Streaming web services to ref-
erence the correct web host location when outputting results that are
returned from an FME Engine, youmust manually change this location in
your FME Engine configuration files:

a. Locate your FME Engine configuration files, under <FME-
ServerDir>\Server\fmeEngineConfig*.txt

b. For each file, under the SUB_SECTION for FILE_DOWNLOAD_
SERVICE and STREAM_DOWNLOAD_SERVICE, modify the
SUCCESS_RESPONSE directive as follows:

From:

SUCCESS_RESPONSE 0:Translation

Successful|OutputLocation=!FME_AUTO_DIR_NAME!

To:
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SUCCESS_RESPONSE 0:Translation

Successful|OutputLocation=

<webHost>/DefaultResults/!FME_AUTO_DIR_NAME_

SIMPLE!

Following the installation on <webHost>, the FME Server Web Application Server
automatically starts.  If you used your ownweb application server, you can restart
that service.

To verify the installation, see "Verify the Installation" on page 14 (Windows) or
"Verify the Installation" on page 20 (Linux).

5.2.2.4 Install the FME Engines

Install the FME Engines by running the FME Server installer on another computer
(<engineHost>). For more information, see "Install the FME Engines" on page
24.

Note: In a high availability environment, we recommend assigning unique
names to FME Engines. However, if multiple FME Engine hosts
have the same FME Engine name, the job routing server con-
figuration applies to all FME Engineswith the same name in the
sameway regardless of which host it resides on. For more infor-
mation about job routing, see "Managing Job Distribution Between
FME Engines" on page 28.
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6.1   Install a Separate License Server

Chapter 6 Licensing

This chapter provides information for licensing FME Engines. Instructions for con-
figuring the number of FME Engines to run are also included.

If you used the express install option or chose to install a License Server with the
custom install option, a FLEXlm license server is already installed. In that case,
see "Request and Install a License" on page 65. If you want to install a separate
external license server, see "Install a Separate License Server" below.

6.1 Install a Separate License Server

A FME floating license allows a networked license server to provide FME floating
licenses tomultiple FME users on a network.

You can use the floating license capability for all FME editions, and a single
license server can serve different FME licenses. For example, if a site requires
floating licenses for both FME Base Edition and FME Server Edition, you can
serve both licenses from one floating license server.

Note: The preceding paragraph does not apply to floating licenseswith dif-
ferent expiry dates.

If you need to transfer an existing floating license server to a different computer,
install the floating license server on the new computer first, and then request a
new license file fromSafe Software.

6.1.1 Before You Begin

Ensure that the following requirements aremet before beginning the installation:

l Ensure that you are running a TCP/IP network.

l Designate one computer on the network as the license server. The license
server can be any computer on the network that is visible to all computers
that are dependent on it for their FME licenses. Select a computer that is
always running and always connected to the network, so that client com-
puters can always communicate with the license server to get licenses for
FME. The processing load on the licensing server is negligible.
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l OnWindows, ensure that you have administrator privileges to install the
FME floating license server.

l If the computer you want to use as your floating license server has a fire-
wall, open a range of ports through which the FlexServer can com-
municate. By default, the range of ports used is 27000-27009, although
you can also configure other ports.

l If FLEXlm is already installed on your license server, you still need to per-
form a new installation. FME 2011 requires the version of FLEXlm that is
included in the installer. In addition, if your organization is configuring
license borrowing, use LMTOOLS version 11.8 or newer.

Note: The FME license server cannot be installed on a virtual computer
that might bemoved around to different physical computers. It
must be locked to a single fixedMAC address.

6.1.2 Download and Run the Installer

6.1.2.1 Windows

You can download the installer fromSafe Software’s site:

http://www.safe.com/fme/fme-technology/fme-server/download/

On the computer that acts as the license server:

1. Run (double-click) the installer to create a FlexServer directory.

The following table lists the shortcuts that are created in the Safe Soft-
ware program group.

Shortcut Description

Generate hostid.txt Creates text file to send to
codes@safe.com.

Launch LMTOOLS Launches LMTOOLS. Used for debug-
ging or changing configuration.
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6.1   Install a Separate License Server

Shortcut Description

License Administration
Guide

Opens Flexera Software’s License
Administration Guide.

Start - Restart FME License
Server

Starts the license manager process.

View FME License Server
Log

Opens the license manager log file.
Used for debugging.

View hostid.txt Reopens text file to send to
codes@safe.com.

View Readme Opens the installation and con-
figuration instructions.

Note: Current versions of lmgrd licensemanager and lmutil end
user utilities are also available from the Downloads area of
www.flexera.com.

6.1.2.2 Linux/UNIX

Locating the FLEXlm License Server Files

Read and understand the following steps before attempting to use FLEXlm licens-
ing on Solaris™ or Linux on x86 and x64.

If you purchased an FME floating or single-fixed license for UNIX, copy the solar-
is2\FlexServer or Linux\FlexServer directories from the FME installation
disk, or go to Safe Software’s FTP site and save one of the following files:

l ftp://ftp.safe.com/fme/floatingLicense/FlexServer11_8-

linux-x64.tar.gz

l ftp://ftp.safe.com/fme/floatingLicense/FlexServer11_8-

linux-x86.tar.gz

l ftp://ftp.safe.com/fme/floatingLicense/FlexServer11_8-

solaris-sparc64.tar.gz

This directory contains the lmutil and lmgrd files required to set up a FLEXlm
server on UNIX, and it contains the FLEXlm license server software. Install this
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software on your license server computer, which is the computer that manages
the licenses.

Note: Current versions of lmgrd licensemanager and lmutil end user
utilities are also available from the Downloads area ofwww.fle-
xera.com.

Creating a Directory for the FLEXlm License Server

Create a directory for the FLEXlm license server, and extract the contents of
flexServer11_8-solaris-sparc64.tar.gz or flexServer11_8-linux-
x64.tar.gz into that directory. For example:

% mkdir /opt/FlexServer

% cd /opt/FlexServer

% gunzip < ~/flexserver11_8-solaris-sparc64.tar.gz |

tar xf -

This directory is referred to as the FlexServer directory for the remainder of
these instructions.

Starting the License Server

Note: To start the Flex Server, verify that the /usr/tmp directory exists.
If it does not exist, create it by entering:

% mkdir /usr/tmp

To start the license server, enter:

% <FlexServerDir>/lmgrd -c <FLEXServerDir>/safe.lic

This action runs the server in the foreground, logging activity to the terminal. To
store the log to a file instead, use the -l option:

% ./lmgrd -c ./safe.lic -l safe.log

When a log file is used, lmgrd detaches as a background process, so there is no
need to explicitly put the application in the background . However, youmust start
the server each time the license server host is rebooted. The system
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6.2   Request and Install a License

administrator canmake sure the preceding command is run at system start-up
time.

6.2 Request and Install a License

6.2.1 Windows

On the computer that acts as the license server:

1. Open your hostid.txt file:

Click Start > Programs > FME Server > Install > Generate hostid.txt

2. Complete the online license request form:

http://www.safe.com/activation/floating/

Youwill need either:

l A trial activation code (e.g. EDHAKQ5W) or

l A product serial number (e.g. BEGP-F7MG-21YL).

Note: If you don't have a trial activation code or product serial
number, please email your hostid.txt file to
codes@safe.com

3. You will receive an email with instructions for installing the license:

a. Save the safe.lic:

l <FMEServerDir>\Utilities\flexserver\safe.lic

b. Restart FME Server and FME License server:

l Start Menu > Programs > FME Server > WindowsService > Restart

If you are using the built-in FME Server License Server, the following start menu
items apply:

l Start > All Programs > FME Server > Install > View hosted.txt

l Start > All Programs > FME Server > WindowsService > Restart
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6.2.2 Linux/UNIX

6.2.2.1 Providing the Information to Generate a Floating License

Safe Software requires three pieces of information to generate a floating or
node-locked license:

l Hostname

l Host ID

l FME serial number

The following sections provide details about these requirements.

Obtaining the Hostname

To obtain the hostname, type the hostname command. For example:

% hostname

worf

In this example, the host name is worf.

Determining the Host ID

To determine the host ID, use the lmutil lmhostid commandwithin the Flex-
Server directory. The output is an eight-character alphanumeric string (or a 12-
character alphanumeric string on Linux/UNIX). For example:

% ./lmutil lmhostid

lmutil - Copyright (c) 1989-2009

The FLEXlm host ID of this computer is "807abc12"

In this example, the host ID is 807abc12.

Determining the FME Serial Number

To determine the serial number, look at your welcome letter or your invoice.

Send an email message to codes@safe.com, and include the host ID, the host
name, and the FME serial number. Safe Software will email you a file called
safe.lic that contains the key code file for the license code server.
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6.3   Configuring FME Server to Use a License Server

Copy the safe.lic file into the FlexServer directory on your license server com-
puter.

Note: The filenamemust remain in lower case text. We recommend that
you do not change the filename. If you want to change the file con-
tents (for example, change a port number), refer to the FLEXlm
User’s Guide, available on your FME installation disk.

If you are using the built-in FME Server License Server, the License Server direc-
tory is:

<FMEServerDir>/FMEServer/Utilities/flexserver

6.3 Configuring FME Server to Use a License Server

6.3.1 Windows

1. To open the FME Licensing Assistant, click Start > Programs > FME
Server > Licensing > FME Licensing Assistant.

2. Enter the name of the computer that is hosting the FME licenses.
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FME Server requires an Engine license and takes that type automatically.
If no Engine licenses are available, FME Server cannot be licensed.

3. Click Activate to complete the connection.

Youmust restart FME Server to use the license. See "Starting and Stopping
FME Server" on page 13 for details.

6.3.2 Linux

6.3.2.1 From the graphical user interface

1. When FME Server is installed on Linux, log in as the same user who
installed FME Server.

2. Navigate to Applications > FME Desktop > Administration Tools > FME
Licensing Assistant.

The FME Licensing Assistant opens.

3. On the FME Licensing Assistant, select Connect to a floating license
server button.
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4. In the Server Name field, enter the name of the license server, and then
click Next.

FME Server requires an Engine license and takes that type automatically. If
no Engine licenses are available, FME Server cannot be licensed.

6.3.2.2 From the command line

1. Open a terminal window.

2. Change to the FME Engine directory:

cd <FMEServerDir>/Server/fme

3. Run the following command to configure the FME Engines to use the
License Server:

./fmelicensingassistant --floating 

[LicenseServerHost> server

6.3.3 UNIX

6.3.3.1 To license an installation of FME Server on UNIX

1. Create a text file called fme_license.dat in
<FMEServer>/Server/fme/licenses.

Theremight be a template file already in this directory called flexlm_con-
fig.dat.template. If so, you can simply rename this file to fme_
license.dat. This is the file that tells FME which computer to connect with
when looking for license information.

2. Edit the file that contains the following information:

SERVER <ServerHostName> Any

USE_SERVER

where <ServerHostName> is replaced by the name of your floating license
server computer. (Thismight or might not be the same computer.)

In the previous examples, the license server was installed onto a host
named worf on a local network, using the default port number. The fol-
lowing command uses this example to create the needed license file.
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% cd /opt/fme

% cat > fme_license.dat

SERVER worf Any

USE_SERVER

<Ctrl+d>

(Typing Ctrl+d ends the input to fme_license.dat.)

3. Restart FME to use this license.

See "Starting and Stopping FME Server" on page 13 for details.

Note: Any examples shown here are simple configurations based
on default port numbers. However, FLEXlm allows you to
set up other configurations, as well as specify locations for
the license server using environment variables. If you want
to do this, skip the following procedure and refer to
detailed instructions in the FLEXlmUser's Guide.

6.4 Configuring the Number of FME Engines to Start

FME Engines connect to an FME Server Core and process requests from the
Core. Adding FME Engines connected to the Core increases its ability to per-
form concurrent processing of requests.

The number of licensed FME Engines you can add is limited only by the host's
CPU andmemory resourceswhich constrain themaximum concurrent request
throughput.

By default, FME Server is configured to start two FME Engines, if two licenses
are available. If only one license is available, only one FME Engine starts.

The followingmethod is available for adding an FME Engine to an existing FME
Server installation. It is applicable toWindows, Linux, and UNIX.

6.4.1 Editing the Process Monitor Configuration

To add an FME Engine by editing the ProcessMonitor configuration:

Chapter 6   Licensing

70 FME Server Administrator's Guide



6.4   Configuring the Number of FME Engines to Start

1. Open the following file using a text editor:

<FMEServerDir>\Server\processMonitorConfig.txt

2. Add a new FME Engine by locating and commenting out the two lines that
start with:

CMDFMEEngine_Engine3=...

WAITFMEEngine_Engine3=...

Similarly, if you would like to remove an FME Engine, you can comment out
these lines.

3. Save and close the file.

4. Restart FME Server.

5. You can confirm that the FME Engines are licensed and running using the
WebUser Interface and the instructions in "Verify the Installation" on page
14.
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7.1   Full FME Server Upgrade

Chapter 7 Upgrading FME Server

This chapter provides information for upgrading to newer versions of FME Server
onMicrosoft Windows, Linux, or UNIX platforms. The basic steps are:

l Back-up your configuration.

l Uninstall FME Server.

l Install the newer version.

l Replace your configuration.

Details about upgrading only FME Engines are also included in this chapter.

7.1 Full FME Server Upgrade

7.1.1 Backup Configuration

This section explains how to back up your FME Server 2012 repository, job his-
tory, and any customizations you have done.

Note: For information on backing up FME Server versions 2013 and later,
see "Backing Up an FME Server Configuration" on page 113

7.1.1.1 Export Repositories

You can use the FME Server Repository Reader/Writer in FMEWorkbench to
back up and restore your existing workspaces, data, and templates. Use FME
Desktop 2012 to back up your FME Server 2011 repository and restore it to FME
Server 2012.

The following procedure does not back up the FME Server job history in the data-
base.

To back up your FME Server repository fromWorkbench:

1. Start FMEWorkbench 2012.

2. Create a new workspace by selecting File > New.

3. In the CreateWorkspace dialog, select Generate workspace and click
Choose.
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TheGenerateWorkspace dialog opens.

Chapter 7   Upgrading FME Server

74 FME Server Administrator's Guide



7.1   Full FME Server Upgrade

4. Select FME Server Repository as the Reader Format, and click the Reader
Parameters button to display the Repository parameters dialog.
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5. Enter the information required to connect to a running FME Server, and
then clickOK.

6. Select FME Feature Store (FFS) as your Writer Format, and enter a
Writer Dataset file path to the FFS file where you want to store the
backup.

Chapter 7   Upgrading FME Server

76 FME Server Administrator's Guide



7.1   Full FME Server Upgrade

7. ClickOK.

The Select Feature Types dialog opens.
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Each feature type represents an FME Server repository. The FMEServer
Services feature type contains the workspace service registration infor-
mation, which you should keep, in most cases.

8. Select the feature types (repositories) you want to export, and then click
OK.

The initial workspace opens.
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Note: When the workspace is created, you can still remove repos-
itories that you do not need to export. Select them in the
workspace, and then click Delete.

9. Click to run the workspace.

10. When the translation completes, navigate to theWriter Dataset file path to
see the results:

Note: For instructions for restoring your repository after you
upgrade FME Server, see "Restore Configuration" on page
82.

7.1.1.2 Backing Up User Accounts, Topics and Subscriptions

Currently, there is no way to back up and replace user accounts, roles, topics, sub-
scriptions or configured resources. Make a note of your existing set-up, so you can
reconfigure it after the upgrade.

Backing up the Web User Interface Configuration Files

This section applies if you have customized the appearance of any of the FME
Server web pages.

FME Server administrators can configure the cascading style sheets (CSS),
JavaServer pages (JSP), or HTML template provided with FME Server. Upgrad-
ing FME Server overwrites these files. These filesmay be stored in the following
locations:

l JavaServer pages:

<Web App Install DIR>\webapps\<webApp>\styles\WEB-INF\jsp\*

l Cascading Style Sheets:

<Web App Install DIR>\webapps\<webApp>\styles
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All files installed by FME Server in your web server public root directory are
removed on uninstall.

Backing Up the Service Configuration Files

Often, when configuring the FME Server services, changes aremade to the
propertiesFile.properties files. FME Server overwrites these files before
install, so be sure to back them up:

<webAppDir>\webapps\<Servlet name>\WEB-

INF\conf\propertiesFile.properties

Backing Up the FME Server Configuration Files

It is a good idea to back up the various configuration files that are used by FME
Server, in case you need to refer to them later:

l <FMEServerDir>\Server\processMonitorConfig.txt

l <FMEServerDir>\Server\fmeServerConfig.txt

l <FMEServerDir>\Server\fmeEngineConfig_#.txt

7.1.2 Backup History

7.1.2.1 Job History

You can preserve the FME Server job history when upgrading FME Server, if
desired.

Create and run a workspace that reads the following tables directly from your
repository database and writes to FFS:

l fme_jobs

l fme_job_result

l fme_job_request

Note: If you are using the Default Database Server, connection infor-
mation can be found under 'Database Connection' in the fme-
ServerConfig.txt file, located in the Server folder of your FME
Server installation directory.
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Log Files

To preserve the log files, make a backup of the <FMEServerDir>\Logs directory.

7.1.3 Uninstall

After you back up your repository and any configurations and before you install the
newest FME Server version, youmust uninstall the previously installed version of
FME Server.

7.1.3.1 Stopping FME Server and the Web Application Server

For the uninstall process to complete properly, youmust first stop both
FME Server and your web application server:

To stop FME Server:

l For Windows environments, select Start > All Programs > FME Server >
WindowsService > Stop.

l For Linux/UNIX environments, run the stopServer.sh script in <FME-
ServerDir>/Server. It should display:

Shutdown status = Shutdown Success

The procedure for stopping the web application server depends on which one you
have installed. For further information, refer to the documentation for your appli-
cation server.

For the uninstall process to complete properly, youmust first stop both
FME ServerIf you installed FME Server using the "Express Installation for Win-
dows" on page 11:

l For Windows environments, select Start > All Programs > FME Server >
WindowsService > Stop.

Note: If you have not used the Express Installer and have used an exist-
ingWeb Application Server and another repository database
option, please shut down those services in addition to FME Server
service before uninstalling.

7.1.3.2 Uninstalling Previous Versions of FME Server

Uninstall the previous version of FME Server:
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l For Windows environments, uninstall FME Server through the Control
Panel.

l For Linux/UNIX environments, remove the following:

l Your FME Server directory

l All FME .war files and their associated FME servlet directories
from the web application deployment directory of your application
server

l The fmedatadownloadresults directory from your web server
public root directory, if it exists

7.1.4 Install

Depending on your operating system, perform the installation and licensing pro-
cedures in the following sections:

l For Windows environments, see theWindows section in "Express Instal-
lation for Windows" on page 11.

l For Linux/UNIX operating environments, see the Linux/UNIX section in
"Performing the Installation for Linux/UNIX" on page 17.

7.1.5 Restore Configuration

Perform the following procedure to use FME Workbench to restore the repos-
itory data that you backed up previously. See "Backup Configuration" on page
73.

Note: This procedure assumes that you are using FME Desktop 2013 to
restore a repository to FME Server 2013. For instructions for
other scenarios, contact fmeserversupport@safe.com.

For Linux/UNIX users, aWindows FME Desktop is required for
these steps.

1. Start FMEWorkbench.

2. Select File > New.
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3. Select Generate workspace.

The CreateWorkspace dialog opens.

4. Click Choose to open theGenerateWorkspace dialog.
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5. Select FME Feature Store (FFS) as your Reader Format.

6. Click to open the Select File dialog.
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7. Select the FME Feature Store (FFS) files containing the FME Server repos-
itories that you want to import, and then clickOpen.
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8. In the GenerateWorkspace dialog, select FME Server Repository as the
Writer Format.

9. Click theWriter Parameters button to open the Repository Parameters
dialog.
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10. Specify the information required to connect to your running FME Server,
and then click Next.
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11. Specify the action to be taken when a repository, item, or resource
already exists:

l Append: If a repository already exists, theWriter attempts to add
the new items only. If an item or resource already exists, theWriter
skips it.

l Merge: If a repository already exists, theWriter adds new items
and updates to those that already exist. TheWriter also updates a
resource, if it already exists.

l Drop: If a repository already exists, theWriter drops it. Then the
Writer adds the new items and resources.

12. Click Finish.

13. In the GenerateWorkspace dialog, clickOK.
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This causes the Select Feature Types dialog to open. Each feature type rep-
resents an FME Server repository (except for the one named FME-
ServerServices, which containsmetadata related to FME Server
services).

14. Select the feature types (repositories) that you want to import, and then
clickOK.

When the workspace is created, you can still remove repositories that you
do not need to import. Select them in the workspace, and press the Delete
button.

Note: FME Server always includes the Samples repository. Rather
than restoring this repository from your previous FME
Server version, we recommend that you use the Samples
repository included with the new FME Server version.
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15. Click to run the workspace.

This creates the respective repositories, copies the workspaces, and reg-
isters the workspaceswith the FME Server.

16. If the hostname of the new FME Server installation differs from the host-
name of the previous FME Server installation, you will need tomodify the
Web Service URL patterns because theywill be preserved from the pre-
vious installation. Log into theWebUser Interface, click the Services tab,
andmodify each Service URL pattern to use the new hostname.

7.1.5.1 Restoring User Accounts, Topics and Subscriptions

If you backed up your user accounts, roles, topics, subscriptions and resources,
as defined in "Backup Configuration" on page 73, set up the security using these
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settings.

7.1.5.2 Restoring Web User Interface Configuration Files

If you backed up your cascading style sheets (CSS), Java Server pages (JSP) or
HTML templates, as instructed in"Backup Configuration" on page 73, replace
these files.

7.1.5.3 Restoring Service Configuration Files

If you backed up your service configuration files
(propertiesFile.properties), as instructed in"Backup Configuration" on
page 73, youmight have to reconfigure any changes youmade to the default prop-
erties. Because new service propertiesmight be added with each release, do not
simply replace the new properties files with your backed-up files. The best
approach is to find the properties edited in the previous installation and edit these
properties in the new version of these files.

7.1.5.4 Restoring Job History

Create and run a workspace that reads the FFS file you created from the FME
Server repository database and writes directly to your repository database:

fme_jobs

fme_job_result

fme_job_request

7.1.5.5 Restoring Log Files

Copy the backed up logs directory into the new Logs directory:

<FMEServerDir>\Logs

7.2 FME Engine Only Upgrade

FME Engine is the component of FME Server that performs the actual data trans-
lations and transformations. At times, youmight want to upgrade only your FME
Engines and not any other FME Server components. For example, youmight
want to provide support for recently added formats or other newer functionality
included in a new release of FME without upgrading other FME Server com-
ponents.
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The procedure described in this section uses the standard FME installer pro-
vided on the Safe Software web site and can be performedwith an official or
beta release of the FME Engine installer.

7.2.1 Obtaining the Installer

Install the upgraded FME Engine in its own path rather than overwriting the exist-
ing FME Engine. This way, you can reverse the upgrade if required.

To upgrade only the FME Engine component when installing an FME Server
environment, use a stand-alone FME Engine installer, not the FME Server
installer, and follow these steps.

You can get the appropriate FME Engine Installer from this
location: http://www.safe.com/support/support-resources/fme-downloads/fme-
server/. The web page also includes download links to release and beta instal-
lation packages for various platforms.

7.2.2 Install on Windows

7.2.2.1 To install FME Engine in a Windows environment

1. Run the FME installer on any computers that are running FME Engines
that you want to upgrade.

We recommend that you leave the existing FME Engine in place as a
backup:

<FMEServerDir>\Server\fme

and create a new directory for the upgraded FME:

<FMEServerDir>\Server\FMEEngineUpgrade

2. Youmust license your new FME Engineswith an FME Engine-level float-
ing license.

For detailed licensing instructions, see "Licensing" on page 61.

3. OpenWindowsExplorer.

4. Make a copy of the file <FME-
ServerDir>\Server\FMEEngineUpgrade\fme.exe, place that copy in
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the same <FMEServerDir>\Server\FMEEngineUpgrade directory, and
rename it FMEEngine.exe.

5. Edit the <FMEServerDir>\Server\processMonitorConfig.txt file.

Look for lines that start FME Engines, such as the following:

CMDFMEEngine_

Engine1="C:/apps/FMEServer/Server/FMEEngine.exe

and change the path to the new FME, for example:

CMDFMEEngine_

Engine1="C:/app-

s/FMEServer/Server/FMEEngineUpgrade/FMEEngine.exe

Look for the line:

ENGINE_EXEC_

PATH=C:\\App-

s\\FMEServer\\Server\\fme\\FMEEngine.exe"

and change it to the new FME:

ENGINE_EXEC_

PATH=C:\\App-

s\\F-

MEServer\\Server\\FMEEngineUpgrade\\FMEEngine.exe"

6. Restart FME Server.

7. To confirm that you are using the upgraded FME Engine from the new path
and that you are using the FME build that you require, check the process
monitor log on any computer running an FME Engine:

<FMEServerDir>\logs\processMonitor<date>.log

In the log, you should see your new FME Engine path and build number
reflected in the FME Start-up sections.
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7.2.3 Install on Linux/UNIX

To install FME Engine in a Linux/UNIX environment:

1. Run the FME installer on any computers that are running FME Engines
that you want to upgrade.

We recommend that you leave the existing FME Engine in place as a
backup:

<FMEServerDir>/Server/fme

and create a new directory for the upgraded FME:

<FMEServerDir>/Server/FMEEngineUpgrade

2. Youmust license your new FME Engineswith an FME Engine-level float-
ing license.

For detailed licensing instructions, see "Licensing" on page 61.

3. Edit the <FMEServerDir>/Server/processMonitorConfig.txt file.

Look for lines that start FME Engines such as the following:

CMDFMEEngine_

Engine3="/opt/fmeserver/Server/fme/runfme"

and change the path to the new FME, for example:

CMDFMEEngine_

Engine3="/opt-

/fmeserver/Server/FMEEngineUpgrade/runfme"

4. Restart FME Server.

5. To confirm that you are using the upgraded FME Engine from the new
path and that you are using the FME build that you require, check the proc-
essmonitor log on any computer running an FME Engine:

<FMEServerDir>/logs/processMonitor<date>.log

In the log, you should see your new FME Engine path and build number
reflected in the FME Start-up sections.
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8.1   Configuring Start-up

Chapter 8 Common Configurations

8.1 Configuring Start-up

8.1.1 Account/User

By default, the FME Server WindowsService is set to use the local system
account, which does not have network permissions.

If FME Server requires access to network directories to read or write data, or if
you use UNC paths to specify a remote repository or upload directory location,
youmight need to run the FME Server WindowsServiceswith a different account.

1. Perform either of the following steps:

1. Select Start > Control Panel > Administrative Tools > Services.

or

2. Run services.msc to open theWindowsServices panel.

2. In the Services list, right-click FMEServer service, and select Properties
from the context menu.
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3. Click the LogOn tab.

4. Select this account, and enter a user account and password that provides
the required network permissions to the FMEServer service.
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8.2   Starting the Services

5. ClickOK.

8.2 Starting the Services

8.2.1 Windows

FME Server is composed of a series of components, and each component is
installed as a standardWindows service. There are amaximumof four services
that can be associated with FME Server. The following sections describe each of
the services.
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8.2.1.1 FME Server Service

This service is themain FME Server service and should always be running. By
default, this service is started at system boot time.

8.2.1.2 FME Server Database Service

On install, if you use the default FME Server database, it creates a service called
FME Server Database, which automatically starts at system boot time. If you
used your own database, such asOracle, ensure that the service starts prior to
the FME Server Service starting.

8.2.1.3 FME Server Application Server Service

On install, if you use the default FME Server Web Application Server, the service
automatically starts at system boot time. If you are using your ownweb appli-
cation server, it is important to note that the FME Server Web Services are
deployed and run by your web application server, not by FME Server itself.
Ensure that your web application server is started for users to access any FME
Server web services including theWebUser Interfaces.

8.2.1.4 FME Server SMTP Relay

This service provides FME Server with the ability to receive email messages. By
default, this service is started at boot time.

8.2.1.5 FME License Server

This service starts the FLEXlm License Server, which provides licenses to FME
Engines. By default, this service is started at system boot time.

Starting and Stopping FME Server Manually

Although the FME Server services start automatically, you can start and stop the
servicesmanually using the standardWindows services control panel.

To access the services control panel fromWindows, perform the following steps.
(Other Windows operating systems have a similar procedure for accessing the
services panel).
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1. Select Start menu > Control Panel > Administrative Tools > Services or
Start menu > Run > services.msc.

2. On the Services panel, scroll down the services list, select the FMEServer,
FME Server Database, FME Server Application, or FME License Server
entry, and start or stop it as required.

3. Start the FME Server service after starting the other services.

Note: You can also start and stop or restart the FME Server serv-
icemanually by going to Start > Programs > FME Server >
WindowsServer > Start, Stop, Restart.

Determining FME Server Processes

Based on your specific environment, youmight need to determine if FME Server
processes are running or not. To do this, launch theWindows TaskManager and
examine its process list. Ensure that the TaskManager is set to show processes
from all users.

The following FME Server processesmight be listed:

l FMEEngine.exe – one for each running FME Engine

l FMEServer.exe - FME Server Core

l FMEScheduler.exe - FME Server scheduler - requires the core to be run-
ning

l FMENotifier.exe – FME Server notifier - requires the Core to be running

l FMEPublisher.exe - FME Server Publication

l FMERelayer.exe - FME Server RelayManager

l FMESMTPRelay.exe - FME Server Email receiver

l FMESubscriber.exe – FME Server subscriber - requires the core to be run-
ning

l FMEServer_Service.exe - FME Server ProcessMonitor - running as a
WindowsService
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l FMEServer_ApplicationServer.exe – FME Server Web Application
Server

l postgres.exe – FME Server Database Server

l lmgrd.exe – FME License Server

8.2.2 Linux/UNIX

You can install FME Server as a system service that starts when you start your
system. You should do this only if you have set up system services before and
understand the different run levels on your system.

Warning: Configuring scripts to run at start-up on Linux/UNIX is an
advanced task. The steps for doing so vary, depending on your
configuration. Use the steps listed in this section as a guide
only.

FME Server is composed of a series of components, and each component has
its own script. There are a few scripts that must bemodified, depending on the
choices youmade during installation. If you performed an express installation or
installed the built-in Database andWeb Application Server, ensure that all
scripts aremoved.

8.2.2.1 Installing FME Server as a System Service

To install FMEServer as a system service, youmust make some changes to the
init.d and rc*.d files:

ll Modify the startup script:

l <FMEServerDir>/Server/startup/FMEServerDatabaseStart

and replace all occurrences of <user>with the name of the user that ran
the installation of FME Server.

l Make a copy of the FME Server start-up scripts:

l <FME-

ServerDir>/Server/startup/FMEServerAppServerStart

l <FMEServerDir>/Server/startup/FMEServerDatabaseStart
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l <FMEServerDir/Server/startup/FMEServerSMTPRelayStart

l <FMEServerDir>/Server/startup/FMEServerStart

placing the scripts here:

l /etc/init.d/FMEServerAppServerStart

l /etc/init.d/FMEServerDatabaseStart

l /etc/init.d/FMEServerSMTPRelayStart

l /etc/init.d/FMEServerStart

l Create links from the scripts you just copied to a script in the correct run
level, depending on your distribution and configuration.

For Debian, this is typically 2 (rc2.d), and for Red Hat and Fedora, this is typ-
ically 5 (rc5.d). If you are unsure what run level you should use, we rec-
ommend that you contact your system administrator before proceeding.

If you are on a Debian based distribution such asUbuntu, you can run the
following commands:

update-rc.d FMEServerStart start 99 2 . stop 98 6

.

update-rc.d FMEServerAppServerStart start 99 2 .

stop 99 6 .

update-rc.d FMEServerDatabaseStart start 98 2 .

stop 99 6 .

update-rc.d FMEServerSMTPRelayStart start 98 2 .

stop 99 6 .

OnRedHat, you can use the chkconfig command. This automatically
adds them to runlevel 3. If you need to use a different run level, you need to
modify the chkconfig header of these scripts, or manually:

chkconfig --add FMEServerStart

chkconfig --add FMEServerAppServerStart

chkconfig --add FMEServerDatabaseStart

chkconfig --add FMEServerSMTPRelayStart
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On other distributions, or to manually set up the startup scripts, create the
proper links in the appropriate run level directory.

The following steps use a run level of 2.

l Create theWeb Application Server startup link:

sudo ln -s

/etc/init.d/FMEServerAppServerStart

/etc/rc2.d/S99fmeserverappserver

l Create the Database Server startup link:

sudo ln -s

/etc/init.d/FMEServerDatabaseStart

/etc/rc2.d/S98fmeserverdatabase

Note: It is important that this is S98, not S99.

l Create the SMTP Relay startup link:

sudo ln -s

/etc/init.d/FMEServerSMTPRelayStart

/etc/rc2.d/S98fmeserversmtprelay

Note: It is important that this is S98, not S99.

l Create the FME Server startup link:

sudo ln -s /etc/init.d/FMEServerStart

/etc/rc2.d/S99fmeserver

l Create theWeb Application Server shutdown link:

sudo ln -s

/etc/init.d/FMEServerAppServerStart

/etc/rc6.d/K99fmeserverappserver

l Create the Database Server shutdown link:
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sudo ln -s /etc/init.d/FMEServerDatabaseStart

/etc/rc6.d/K99fmeserverdatabase

l Create the SMTP Relay shutdown link:

sudo ln -s

/etc/init.d/FMEServerSMTPRelayStart

/etc/rc2.d/K99fmeserversmtprelay

l Create the FME Server shutdown link:

sudo ln -s /etc/init.d/FMEServerStart

/etc/rc6.d/K98fmeserver

Note: It is important that this one is K98, not K99.

l The License Server you usemust be configured to start up prior to FME
Server starting. If you are using the License Server provided by the FME
Server install, the command to start the license server is:

<FMEServerDir>/FMEServer/Utilities/flexserver/lmgrd

-c ./safe.lic -l safe.log

Starting and Stopping FME Server Manually

Although you can configure FME Server to start automatically, you can start and
stop it manually by using shell scripts. To start the server, there are up to three dif-
ferent scripts that must be run, depending on whether you performed the express
installation or installed the built-in Database andWeb Application Server. 

To start FME Server, run the following scripts:

Note: If the port specified during installation is a lower number than 1024,
run the Application Server start-up script as the root user. Run the
other scripts as the same non-root user that ran the installation of
FME Server, with the exception of startFME-
ServerSMTPRelay.sh, which should be run as the root user.

l <FMEServerDir>/Server/startApplicationServer.sh

l <FMEServerDir>/Server/startDatabaseServer.sh script
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l <FMEServerDir>/Utilities/flexserver/lmgrd -c

./safe.lic -l safe.log

l sudo <FMEServerDir>/Server

startFMEServerSMTPRelay.sh

l sudo sh <FMEServerDir>/Server/startServer.sh >

/dev/null 2>&1 &

Note: > /dev/null 2>&1 preventsmessages from outputting to
the console window. Thesemessages can still be
accessed in the log file written to <FMEServerDir>/Logs.
The final & runs the command in the background, return-
ing control of the console to the user while FME Server is
running.

To stop FME Server, run the following scripts:

l <FMEServerDir>/Server/stopServer.sh

l <FMEServerDir>/Server stopFMEServerSMTPRelay.sh

l <FMEServerDir>/Server stopApplicationServer.sh

l <FMEServerDir>/Server stopDatabaseServer.sh

Determining FME Server Processes

Based on your specific environment, youmight need to determine if FME Server
processes are running or not.

You can determine which FME Server processes are running by examining the
output of:

ps -A | grep -i fme

The following FME Server processesmight be listed:

l fme – one for each running FME Engine

l FMEServer - FME Server Core

l FMEScheduler - FME Server scheduler - requires the core to be running
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l FMENotifier - FME Server notifier - requires the core to be running

l FMESubscriber - FME Server subscriber - requires the core to be running

l FMERelayer - FME Server RelayManager

l FMESMTPRelay - FME Server Email receiver

l tomcat7 – FME Server Web Application Server

l postgres – FME Server Database Server

l lmgrd – FME License Server

8.3 Configuring FME Server to Receive Email

To use the email server, you need to change the host to the public DNS name you
plan on assigning to the FME Server. For example, if you are using an AMI the
host name could be ec2xxxx.amazon.com but the public DNS namemay be
demo.safe.com. You want to set the Email host name to the second one in this
case.

1. To change the name, open this file:

<FME Server Install DIR>\Uti-

lities\emailserver\james\apps\james\SAR-INF\config.xml

2. Find the following tags:

<postmaster>Postmaster@localhost</postmaster>

<servername>localhost</servername>

3. Update to the public DNS:

<postmaster>

Postmaster@alertdemo.safe.com</postmaster>

<servername>alertdemo.safe.com</servername>

4. Restart the FME Server SMTP Relay service.

5. If you wish tomake the email server accessible to the Internet the following
portsmust be open:
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l Non-secure: SMTP: 25

l Secure with SSL: SMTP: 465

8.4 Configuring FME Server to Send Email Notifications

TheData Download and Job Submitter services can send email messages on
job completion to notify a user of either job success or job failure. To configure
your email, you need access to an SMTP server.

1. Log in to the FME Server web user interface:

http://<host>/fmeserver

2. Click the Notifications tab, and then click the Subscriptions tab.

3. Select DataDownload_Email_JobFailure.

4. In the resulting form, configure the parameters.

For details on the parameters, see the help available in the FME Server
WebUser Interface.

5. Repeat this procedure for the JobSubmitter_Email_JobFailure, Data-
Download_Email_JobSuccess and JobSubmitter_Email_JobSucess sub-
scriptions.

For more information, see "Email Subscriber" in the FME Server Reference
Manual.

8.5 Configure FME Engine Resources

8.5.1 Shared Resources

FME Server workspaces can use shared custom formats and transformers in
the sameway that FMEWorkbench does. There are two ways to upload your
custom resources to FME Server.

You can publish these custom resources to FME Server for use within a specific
repository by following these steps:

1. Open the custom format or custom transformer in FMEWorkbench:

File > Open > Select custom format/transformer
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2. Publish the resource to FME Server as you would publish a workspace.

The resource then becomes available to workspaceswithin the repository
to which you published it.

You canmake the these custom resources accessible to all workspaces on FME
Server by following these steps:

1. Manually place the transformer in the shared resource directory.

Each FME Engine used by FME Server can have a shared resources direc-
tory defined for it. The location of the directory is based on the FME_
SHARED_RESOURCE_DIR parameter in the FME Engine's configuration file:

<FMEServerDir>\Server\fmeEngineConfig_

<instanceName>.txt

2. Locate the value of the parameter in the configuration file:

FME_SHARED_RESOURCE_DIR

"C:/Apps/FMEServer/Server/Resources/shared"

3. Create a sub-directory called "Transformers" for custom transformers and
"Formats" for customFormats, and then place your resources in those direc-
tories.

Note: If there are two definitions of the same custom transformer,
one in the repository directory and the other in the shared
directory, FME Server tries to find the transformer in FME_
SHARED_RESOURCE_DIR first and use that. If it is not
there, it looks for the transformer defined in the resource
directory.

8.5.2 Custom Coordinate Systems

Although a custom coordinate system cannot be published to FME Server, there
are two ways they can bemade available to the FME Server:
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l Modify the MyCoordSysDefs.fmw file:

Add its definition to the following file where you have an FME Engine
installed:

<FMEServerDir>

\Server\fme\Reproject\MyCoordSysDefs.fme

MyCoordSysDefs.fme is a file that contains custom coordinate systems
defined by the user.

l Add to the shared resource directory:

Place custom coordinate systems in the CoordinateSystems shared
resources directory.

Each FME Engine used by FME Server can have a shared resources
directory defined for it. The location of the directory is based on the FME_
SHARED_RESOURCE_DIR parameter in the Engine's configuration file:

<FMEServerDir>\Server\fmeEngineConfig_

<instanceName>.txt

l Locate the value of the parameter in the configuration file:

FME_SHARED_RESOURCE_DIR

"C:/Apps/F-

MEServer/Server/Resources/shared"

l Within this directory, create a subdirectory called "Coor-
dinateSystems", and place your custom coordinate systems
in that directory.

8.5.3 Configuring Grid Shift Files

If you plan to run workspaces that transform data between the datumsNAD27
and NAD83without explicitly choosing a transformation in a CsmapReprojector
transformer, youmust decide whether to use datum shift files for Canada or the
US. Run one of the following from a command prompt to tell FME which Grid
Shift file to use:
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l Canada: <FMEServerDir>Server/fme/fme APPLY_SETTINGS [SYS-

TEM] "CoordSys/NAD2783 Datum Shift" "canada only"

l US: <FMEServerDir>/Server/fme/fme APPLY_SETTINGS [SYSTEM]

"CoordSys/NAD2783 Datum Shift" "us only"

If SYSTEM is specified, the setting applies to all FME processes run on the
machine. If not specified, the setting applies only to FME processes run by the cur-
rent user.

8.6 Configuring Job Routing

Job Routing is amechanism for sending specific jobs to specific FME Engines.
The reasons for doing this include:

l Reserving an FME Engine for a scheduled task

l Reserving an FME Engine for quick jobs

l Sending jobs to an FME Engine that supports a particular format (for exam-
ple, MS Access is not supported on UNIX)

Job routing uses tags to assign jobs to a subset of available FME Engines.With
tags, you can associate specific jobswith certain engines, or associate all jobs in a
repository with certain engines.

FME Server Administrator's Guide 109



The first step in configuring job routing is determining the names of the FME
Engine instances.

8.6.1 Determine the FME Engine Names

To redirect a job to a specific FME Engine, youmust know the FME Engine's
name. To determine the name:

1. Open the <FMEServerDir>\Server\ processMonitorConfig.txt

configuration file.

2. Scroll down to the bottom of the file to the FME Engine start-up def-
initions.

3. Find the FME Engine definition to which you want to assign the job.

8.6.2 Assigning Jobs to a Subset of Available FME Engines

You can configure the FME Server Core to direct jobswith specific tag to spe-
cific FME Engines. To do so:
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1. Open the <FMEServerDir>\Server\fmeServerConfig.txt con-
figuration file.

2. Under "Job Routing" (at the very end of the file, under "FME SERVER SET-
TINGS START"), add the following syntax to configure the FME Engines to
accept or reject jobswith certain tags:

TM_ENGINE_

<

ConfigNumber

>=<EngineHostName>:<EngineInstanceName>:<TagName>

Note: <ConfigNumber> should start at 1 and increment sequen-
tially.

Note: <EngineHostName> and <EngineInstanceName> are
case-insensitive. <TagName> is case-sensitive.

3. Restart FME Server.

Note: If a high availability environment is configured with multiple FME
Engine hosts having the same FME Engine name, the job routing
server configuration applies to all FME Engineswith the same
name in the sameway regardless of which host it resides on.

8.6.2.1 Example

In this example, any job with the tag"fast" would be processed (accepted) by
engine1 or engine2 (on host "panaka"), while engine3 would process jobswith the
"utility" tag. Any jobswith any other tag or no tag will be processed by any other
engines that have not been explicitly associated with a tag. (By default, these
engines are associated with the TM_DEFAULT_TAG tag.)

TM_ENGINE_1=panaka:engine1:fast

TM_ENGINE_2=panaka:engine2:fast

TM_ENGINE_3=panaka:engine3:utility
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8.6.2.2 Submit a Request with a Tag

The next step is to submit a job with a tag. You can submit a job with a tag using
the web services and HTTP or directly using the FME Server Console.

FME Server Web Services

Open theWebUI, navigate to the service you want, and get the Show Request
value, such as:

http://<host>/fmejobsubmitter/Samples/austinDownload.fmw

Append tm_tag= and the tag to the end of the URL, for example:

http:/-

/localhost/fmejobsubmitter/Samples/austinDownload.fmw?tm_

tag=fast

The FME Server core uses the tag to determine whether FME Engines can
accept the request.

FME Server Console

Append the following text to the submit_job or run_workspace command:

tm_outputFormatTag fast

For example:

run_workspace Samples/austinDownload.fmw tm_tag fast

8.6.3 Configure All Jobs in a Repository with a Tag

You can direct the FME Server Core to assign all jobs submitted from a repos-
itory to whatever engine is specified in the TM_ENGINE_<ConfigNumber>

parameter, regardless of the tag that is associated with a client-side job request.
To do so, use the following syntax in the fmeServerConfig.txt configuration
file:

TM_REPOSITORY_<ConfigNumber>=<

RepositoryName>:<TagName>

Chapter 8   Common Configurations

112 FME Server Administrator's Guide



8.7   Migrating an FME Server Configuration

8.6.3.1 Example

In this example, any jobs from the "Samples" repository are assigned the "fast"
tag. This tag will override any tag assigned to a job in the "Samples" repository by
the client-side job request.

TM_REPOSITORY_1=Samples:fast

8.7 Migrating an FME Server Configuration

You canmigrate the configuration of an FME Server instance to another instance.

Tomigrate the configuration of an FME Server 2013 instance, create a work-
space in FMEWorkbench using the FME Server Configuration reader and writer.
The FME Server Configuration format supportsmigrating repositories, services,
notifications, security and scheduling.

Note: To use the FME Server Configuration format, your user account
must be assigned to the fmesuperuser role.

Note: The FME Server Configuration format does not migrate or backup
the contents of the FME Server configuration files: fmeEn-
gineConfig.txt, fmeServerConfig.txt, processMonitorConfig.txt

Note: The FME Server Configuration format is not compatible with FME
Server version 2012 or earlier.

In the reader, specify the FME Server instance whose configuration you are
migrating. In the writer, specify the FME Server instance to which you aremigrat-
ing the configuration.

For more information about how to use the FME Server Configuration format, see
the FME Readers andWriters Help, included with your FME Desktop installation.

8.8 Backing Up an FME Server Configuration

Beginning with FME Server 2013, a workspace is provided that can be scheduled
to perform a backup of the Server configuration to an FME Feature Store (FFS)
file. The configuration back up includes repositories, services, notifications, secu-
rity settings and schedules.
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Note: To backup the configuration of an FME Server version 2012 or
earlier, see "Backup Configuration" on page 73.

To Enable a Schedule Backup

1. Log into the FME Server WebUser Interface:

http://<host>/fmeserver

2. Click the Schedules tab.

3. Click the Backup_Configuration entry.

4. On the Editing page, check "true" beside Enabled.

5. Edit other parameters as necessary

6. ClickOK.

The following parameters are specific to the Backup_Configuration schedule:

l FME Server Username: The user performing the backup. The user
must belong to the the fmesuperuser role.

l FME Server Password: Password of the user.

l Backup File (FFS): The file to store the backup. The locationmust be
accessible by the engine running the workspace. It can refer to a UNC
path.

l Backup Password: Password to access the backup file.

l Append Date: If Yes, the date and time of the backup is appended to
the filename.

8.9 Purging Logs and History

As FME Server processes jobs, the history of these jobs is stored as records in
the repository database and as log files in the file system. Eventually, the volume
of these records and logs can build up and cause issues, such as slow web inter-
face response time and low disk space. Therefore, FME Server ships with two
workspaces that you can scheduled to purge job history from the database and
log files from the file system.

Chapter 8   Common Configurations

114 FME Server Administrator's Guide



8.10   Changing the Hostname and Web Application Server Port

To enable scheduled purging:

1. Log into theWebUser Interface:

http://<host>/fmeserver

2. Click the Schedules tab.

3. Then:

l To enable log purging, select the Purge_Logs schedule and click Ena-
ble .

l To enable job history purging, select the Purge_Jobs schedule and
click Enable.

By default these schedules are configured to run once per day.

4. To adjust the frequency of the purging, select the schedule, click Configure,
and then adjust the repeat interval and frequency.

8.10 Changing the Hostname and Web Application Server Port

Often you install FME Server and then need to update the hostname or web appli-
cation server port. To change the hostname and/or web application server port
used by FME Server, youmust modify a few configuration files and the FME
Server Services definitions. It’s important to know that theremay bemore than
one location in each file where the hostname needs to change. Using the find and
replace feature in a text editor may provide an easyway to ensure all instances
are updated.

8.10.1 FME Server Services

To change the hostname used by FME Server, you need to update the service’s
URL patterns. To use the web user interface to do this, follow these steps.

1. Navigate to the FME Server WebUser Interface http://<hos-
t>/fmeserver.

2. Log in and click Services on the left-hand side.

3. In the URL Pattern field, make the appropriate changes and clickOK when
done.
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8.10.2 FME Server

Modify the <host> values in the following files:

<FMEServerDir>\Server\processMonitorConfig.txt

CMDStartFMEEngine_1="C:\\Program

Files\\FMEServer\\Server\\fme\\ FMEEngine.exe"

REGISTER_SOCKET <host> 7070 "C:\\Program

Files\\F-

MEServer\\Server\\f-

meEngineConfig.txt"|log|attempts=5

Youwill need to repeat this for each FME Engine you are running. There is a
CMDStartFMEEngine_n block of text for each Engine.

<FMEServerDir>\Server\stop\Server.bat

"<FME-

ServerDir>\Server\..\Utilities\jre\bin\java.exe" -

Xrs COM.safe.processwatcher.SDShutdownAgent <host>

7500 %ADMIN_PASSWORD% MainApplication

8.11 Configuring International Character Encoding

By default, FME Server tries to detect how your web service handles inter-
national character encodings. Beginning with FME Server 2013, you canman-
ually configure the services and theWebUser Interface for international
character encoding. To do this, youmust configure each service and web appli-
cation separately.

To configure international character encoding for a particular service or for the
Web User Interface:

1. Open the web application's deployment descriptor web.xml file. This file is
installed at <webAppDir>/WEB-INF/web.xml.

2. Find the <filter> element with <filter-name>i18nFilter and
<filter-class>COM.safe.web.-

servlet.CharsetEncodingFilter.
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8.11   Configuring International Character Encoding

3. Add/modify the <init-param> directives to configure international character
encodings for this web application according to the table below:

Parameter
Name

Type Description

charset string Sets the character set to use. UTF-8 is rec-
ommended.

detect-
encodings

boolean “true” to automatically detect encodings.
“false” to disable.

auto-
encoded

list A list of comma-separated keywords that spec-
ify what should be encoded by the specified
character set (see charset). Available key-
words:

l querystring – Encode query strings in the
URI.

l path – Encode the path component of the
URI.

l body – Encode the request body for each
request.

For further instructions, see the J2EE Servlet Specification v2.5.
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9.1   Overview of Securing FME Server

Chapter 9 Securing FME Server

FME Server contains a security component that can prevent unauthorized users
from accessing your services and applications, which we refer to as resources.
You use FME Server Security to provide groupswithin your organization access
to different resources. You can also configure FME Server to work with your
organization's existing security infrastructure, such as Active Directory.

9.1 Overview of Securing FME Server

By default, FME Server uses basic authentication to provide the username and
password to the server. This authentication is not encrypted. To ensure that sen-
sitive information is encrypted, we recommend that you use a Secure Sockets
Layer (SSL) connection. SSL encrypts the data, protecting user names and pass-
words frommalicious interception of transactions.

Whenworking with FME Server security, youmust make twomain decisions:

l Which resources should provide unauthenticated access?

l Which resources should users have access to and what permissions should
they have on those resources?

9.2 Disabling FME Server Security

Note: We recommend that security be enabled unless there is a com-
pelling reason to disable it.

FME Server enables security by default. When security is enabled, theWebUser
Interface has log in and log out capabilities. Also, a Security tab appears on the
WebUser Interface to allow you to administer security.

To disable FME Server security, set the ENABLE_SECURITY option to false in the
following configuration files:

l FME Server - <FMEServerDir>\Server\fmeServerConfig.txt

l WebUser Interface - <WebAppDir>\fmeserver\WEB-INF\conf\pr-
opertiesFile.properties
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9.3 Choosing Your Security Framework

The decision about which framework you decide to use depends primarily on
whowill be using FME Server resources. For example, if you are creating Inter-
net applications and your web users are not in your Active Directory, youmight
want to use the default FME Server framework. However, if you are building
applications to be deployed on your intranet, youmight want to leverage your
existing Active Directory to grant access to FME Server resources.

9.3.1 Default Framework

By default, FME Server ships with a built-in securitymodule. Only FME Server
uses this default securitymodule and, as a result, it must bemanaged using the
FME Server WebUser Interface. All users and security information is stored in
the FME Server repository database.

9.4 Connecting to Active Directory

FME Server's security framework can be configured to use Active Directory for
user authentication and user grouping. In thismanner, a server administrator
can utilize an existing user account database and associated security per-
missions.

In Active Directory, user accounts are given security permissions by placing
them in one or more security groups. The integration works by effectivelymap-
ping Active Directory security groups to FME Server roles. In theWebUser Inter-
face, a role is then given a set of resources it can access and permissions on
those resources. Therefore, if a security group has access to a particular
resource, so do itsmember users.

9.4.1 Getting Started

To configure FME Server to use Active Directory, three steps are required:

1. Identify security groups to allow access.

2. Add each security group as a user role.

3. Enable Active Directory integration in the FME Server configuration file.

These steps are described in detail in the following sections.
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9.4   Connecting to Active Directory

This document assumes that you have not modified FME Server security com-
ponents and that you are using the default security settings that ship with FME
Server (that is, the built-in database securitymodule).

9.4.2 Identify Security Groups

Identify the security groups to which you want to allow access to FME Server, and
compile a list their distinguished names (DNs).

You can acquire DNs from the domain administrator or through an Active Direc-
tory browser, such as ADExplorer (http://technet.microsoft.com/en-us/sys-
internals/bb963907). The DN of a security group takes on the general form:

CN=groupname,OU=organizationunit,...,DC=mydomain,

DC=com

Add Security Groups as Roles

Through the FME Server web user interface, add each security group's DN as a
user role. For each user role, specify the FME Server resources that the role can
access.

1. Using a web browser, access the FME Server Web Interface—for example,
http://localhost/fmeserver.

2. If you are not already authenticated, enter your credentials, and click Login.

3. Click Security on the left-hand side to access the security page.

4. Click the Roles tab.

5. Click New, and then specify the the security group's DN.
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6. ClickOK to add the new user role.

The user membership ismaintained in Active Directory.

7. Click Permissions, and select the newly added role.

8. Specify the FME Server resources that you want to make accessible to
this security group, and then click Apply.

9. Repeat steps 4 through 8 for each security group you want to add.

9.4.3 Enable Active Directory

Edit the FME Server configuration file to use Active Directory. Then restart the
server.

1. Open the FME Server configuration file, fmeServerConfig.txt, located
in the subdirectory Server of your FME Server install directory.

2. Under the Security heading, comment out (#) the following line:

SECURITY_LOGIN_TYPE=database

3. Uncomment (#) the following lines:

SECURITY_LOGIN_TYPE=activedirectory

SECURITY_AD_SERVER_AUTODETECT=true

FME Server will attempt to automatically detect Active Directory. If this
fails, provide the host and port for your Active Directory using the following
lines:

SECURITY_AD_SERVER_AUTODETECT=false

SECURITY_AD_SERVER_COUNT=1

SECURITY_AD_SERVER_HOST1=<host>

SECURITY_AD_SERVER_PORT1=<port> (typically 636)

4. If you would rather not have to enter your domain name each time you log
in (<domain>\<user>), uncomment the following line and provide your
domain:

SECURITY_AD_NT_DOMAIN=<yourDomain>
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9.4   Connecting to Active Directory

5. If you are connecting to Active Directory over a Secure Sockets Layer
(SSL), add the following line:

SECURITY_AD_USE_SSL=true

6. Save the configuration file.

7. Restart FME Server.

For more information, see "Starting and Stopping FME Server" on page 13.

8. Log in using your Active Directory credentials.

9.4.4 Security Management Using Active Directory

When using Active Directory for user authentication and authorization, the Secu-
rityManagement interface has somemodifications.

l TheUser Accounts view displays a live list of Active Directory users who
can access components of FME Server.

l TheUser Roles view continues to display all available user roles, including
those that are not Active Directory security groups.

9.4.4.1 User Accounts View

TheUser Accounts view is a live list of Active Directory users that can access com-
ponents of FME Server. A server administrator cannot modify this list, since it is
fetched fromActive Directory. The list includes all users implicated by the enabled
Active Directory security groups specified in user roles.

Note: FME Server populates this view by using Lightweight Directory
Access Protocol's (LDAP) virtual list view (VLV) control. Your
Active Directory server must have this feature enabled in order to
display a live User Accounts view.

9.4.4.2 User Roles View

TheUser Roles view is a live list of Active Directory security groupswho can
access components of FME Server. A server administrator canmodify this list,
which is stored in the local security database, to add Active Directory security
groups or remove existing groups.
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Note: User roles can accept Active Directory security groups only. It is
possible through the user interface to add user roles that are not
security groups; however, they are ignored. Examples of invalid
user roles when using Active Directory include:

l Active Directory user accounts

l Built-in database user roles (for example, fmead-
min)

9.4.5 Troubleshooting

Active Directory-based securitymight be easier to set up in some server envi-
ronments, due to the high degree of variability of the security hierarchy. If you
are having difficulty configuring FME Server's security framework to use Active
Directory, check the following troubleshooting tips for options.

9.4.6 Enabling Debug Logging

Enabling debug logging for FME Server's security framework allowsmore ver-
bose logging duringmany Active Directory operations. Examining logmessages
might provide insight into the failing operation.

1. Open the FME Server configuration file, fmeServerConfig.txt, located
in the subdirectory Server of your FME Server install directory.

2. Under the Security heading, locate the parameter SECURITY_DEBUG and
set it to true.

3. Restart FME Server.

For more information, see "Starting and Stopping FME Server" on page
13.

4. Examine the log files for additional information pertaining to Active Direc-
tory operations.

9.5 Default User Accounts

To get you up and running quickly with the FME Server Security, default user
accounts are provided with default permissions. (See "Before You Begin" on
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9.6   Securing FME Server and Applications/Services

page 5 for details.) As an administrator, you can reset these accounts using the
FME Server WebUser Interface.

Note: If you would like all of the web services to prompt for authentication,
remove the guest account after you configure your own set of
users and access control for your server.

9.6 Securing FME Server and Applications/Services

FME Server allows you to secure your Web applications andWeb services. There
are threemain tasks you need to performwhen configuring access to your Web
services and applications:

l Configuring which components require authentication

l Configuring permissions for resources

l Implementing Secure Sockets Layer (SSL)

9.6.1 Disable/Enable Authentication for Resources

You can configure FME Server so that someweb services require user cre-
dentials and others do not. For example, youmight want to allow open access to
the Data Download service but restrict access to the Data Streaming service.

This can be accomplished by using the guest user account, which is amember of
the fmeguest role. If the fmeguest role has been assigned access to a resource,
that resource does not require or request authentication.

By default, the fmeguest role has access to all of the web services, whichmeans
that the web services provide unauthenticated access by default. You can adjust
the resources that the fmeguest role has access to using theWebUser Interface.

9.6.2 Configuration

You configure security configuration, including authentication and access control,
using the FME Server WebUser Interface, where a Security tab appears, if secu-
rity is enabled. The Help link in theWebUser Interface provides further details on
any of the configuration steps described below, such as adding and removing
users, changing passwords, and granting access to components.
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9.6.2.1 Users and Roles

FME Server allows you to assign access rights to different roles for the web serv-
ices, applications, and components associated with FME Server. A role is a
group of one or more users. A user is the person who accesses the applications
or services, and a user can belong to one or more roles.

Before assigning permissions to users and roles, youmust define where those
users and roles originated. See "Choosing Your Security Framework" on page
120 for details on how to do this.

The Security page of theWebUI is where administrators define permissions. It
uses the following hierarchy:

l User Accounts

l User Roles

l Resources

l Permissions

9.7 Repository Security

Repositories provide a way to group andmanage workspaces on FME Server in
ameaningful way. FME Server allows an administrator to assign finely grained
permissions on a repository to specific roles. That means that different users can
have varying levels of access to different repositories.

Details on how to assign permissions to repositories are provided in the web
help within theWebUser Interface.

9.8 Topic Security

Topics are a Notification Service tool for managing Publishers and Subscribers.
Role-based permissions for topics include Read,Write, Publish and Remove.

Details on how to assign permissions to topics are provided in the web help
within theWebUser Interface.
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9.9   Configuring for HTTPS

9.9 Configuring for HTTPS

HTTPS ensures that communication between the client and server is encrypted,
so that if it is intercepted, the third party cannot easily view or use the information.
For FME Server, you can use HTTPS to ensure that sensitive log in information is
not exposed. This is especially important if you are using the Active Directory inte-
gration.

9.9.1 Enabling FME Server SSL Support

To enable SSL support:

1. Modify service URLs to use HTTPS instead of HTTP.

2. Enable SSL on the web and/or application server.

9.9.2 Modifying Service URLs to Use HTTPS

To enable SSL for a service, open the FME Server WebUser Interface, click Serv-
ices, and click the desired service in the table.
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The Editing Service page opens.

In the URL field, change HTTP to HTTPS, andmodify the port number, if
required. Typically SSL is configured on either port 8443 or 443.

9.9.3 Enable SSL on the Web and/or Application Server

Depending on themethod, instructions to set up SSL on different application
servers vary. The following example provides steps for setting up SSL for
Apache Tomcat 7, using self-signed certificates.

For development and testing purposes, self-signed certificates are supported.
For production use, we recommend that you use SSL certificates from a verified
SSL certificate authority.

For anyHTTPS (SSL) page, a certificate is required. First, youmust generate a
keystore that contains a certificate chain using the keytool command from the
Java Developer Kit (JDK).

To set up SSL for Apache Tomcat 7 using self-signed certificates, follow these
steps:

Chapter 9   Securing FME Server

128 FME Server Administrator's Guide



9.9   Configuring for HTTPS

1. Open the command prompt.

2. Type the following command:

keytool -genkey -alias tomcat -keyalg RSA

If your path is not set to the Java bin directory, navigate to that directory
and type the appropriate command.

Note: A JDKmust be installed to use the keytool command.

A message prompts you to enter a keystore password.

3. Enter changeit.

You can give the keystore password a different name; however, if you do,
youmust make some changes later.

4. Enter the required details, shown here:

A message prompts you to enter the alias password, whichmust be the
same as the keystore password.

5. Enter the same password you entered in step 3.

A keystore is generated in the following location:

<drive>:\Users\<username>\.keystore
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where <drive> is C: and <username> is hnguyen.

6. Copy the .keystore file to the Tomcat directory, and then copy the path
to the file.

If you are using the default web application included with FME Server,
Tomcat is located at:

<FME Server Install DIR>\Utilities\tomcat

7. Open the server.xml file:

<TomcatDir>\conf\server.xml

8. Locate the Connector code block, and replace it with the following:

<Connector

pro-

tocol="org.apache.coyote.http11.Http11Protocol"

port="443" minSpareThreads="5"

enableLookups="true"

disableUploadTimeout="true"

acceptCount="100" maxThreads="200"

scheme="https" secure="true" SSLEnabled="true"

keystoreFile="C:\Program Files\Apache Software

Foundation\Tomcat 6.0 2010

beta\conf\.keystore"

keystorePass="changeit"

clientAuth="false" sslProtocol="TLS" />

9. Be sure to set the keystoreFile path to the correct location and the key-
storePass to the password you entered in step 3.

10. In the Apache Tomcat's server.xml file change the Listener class-

Name line (found at the beginning of the file) to how it's written below:

<Listener

class-

Name="org.apache-

.catalina.core.AprLifecycleListener"

SSLEngine=‘off'/>

11. Your configuration is complete so save the server.xml file.
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9.9   Configuring for HTTPS

12. Restart your Tomcat application.

13. If you are using the default FME Server Application Server, restart that serv-
ice.

14. Open a browser and navigate to https://localhost.

This should show you the same Tomcat home page, but in a secured for-
mat.

Note: If you use port 443 in your Tomcat server.xml file, you're
able to omit the port number in your URL links; that is, you
only need to type https://localhost.
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